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Abstract

The purpose of this study is to develop a training module for integrating text, artwork, and

graphics into a page layout program. Currently, the information for successful integration

must be referenced from several sources. By having the key elements of integration in one

volume, users attempting to layout and/or design a publication using these programs will

be able to proceed quickly with fewer technical problems.

Rapid growth is predicted for computer-based tools in graphic design studios,

advertising agencies, and magazines which normally use computer design stations. These

computer design stations require proper training to be used cost effectively. Consequently,

training is important for firms investing in them.

For the types of publications produced by graphic design studios, advertising

agencies, and magazines, training is recommended by the author in the following five

areas: word processing, artwork, graphics, page layout, and integration of programs. The

manuals available for the individual programs were found to be adequate except in the area

of integration. The information was spread out over several manuals and tended to assume

more than entry level knowledge of computer vocabulary.

The goal of this project is to bring the integration information together into one

resource. Each stage of integration will be explained for a user who is not computer

literate. It is necessary to specify programs for the integration training module since

different programs have different requirements for integration. Programs were selected

based on popularity, extensive use, and technical competence in the graphic arts industry.

This project is comprised of two components. The first and major phase of the

project is the experimentation, research, and writing of the integration training module.

The final product will be an integration training module in the form of a reference manual.

Research and experimentation will determine the specific contents and instructions for

each chapter.



The second component is the evaluation and subsequent revisions. A panel of

judges will be asked to use the integration training module. The judges will then evaluate

the module by completing a questionnaire designed to evaluate accuracy, clarity, ease of

use, and usefulness. After reading the evaluations, revisions will be made to the module.

n
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DEFINITION OF TERMS

Artwork programs Specialized software programs that allow users to generate

artwork on a computer. Referred to as draw/paint programs.

Desktop publishing (DTP) The DTP process brings text, artwork, graphics, and page

layout programs together, eliminating separate typesetting and

image functions. Camera-ready copy is prepared at a computer

work station.

Graphics programs Software offering image editing and camera preparation for

scanned images (graphics).

Integration The process of importing one ormore files from one software

program into another software program.

Module A training unit that is one complete segment of a larger

training program.

Page layout programs The primary function is designing of page(s) that utilize both

text and graphics.

Publication/publishing Small-to-medium sized printed pieces requiring text, artwork,

and graphics. Types ofworks printed are annual reports,

brochures, advertisements, newsletters, and magazines.

VI



Scanned images Images scanned into the computer work station through the

use of a flatbed scanner.

Word processing The primary function is formatting straight text matter.

The definitions above are the meanings that are meant to be portrayed in this project

proposal. The terms may have other meanings and interpretations in other contexts.

vn



INTRODUCTION

Purpose of the Study

The purpose of this study is to develop an integration training module that is intended to

guide users through the essential stages of importing text, computer-generated artwork,

and scanned graphics into a page layout program. Currently, the information for successful

integration must be referenced from several sources. By having the key elements of

integration in one volume, users attempting to layout and/or design a publication using

these programs will be able to proceed quickly with a minimum of frustration.

A quick reference guide, which will accompany the integration training module,

will aid in visualizing the content of the integration training module (Figure 1). The

Quick Reference Guide illustrates the layout for a piece to be published. The user wishes

to import the actual textmatter from aMacWrite file and artwork from Adobe Illustrator.

Scanned images of a variety of types are to be imported from MC View Plus II. The

stages and the considerations at each stage are illustrated in a flow chart format. The

research and experimentation of this project will provide the specific instructions at each

stage to make this importation process quicker and easier for the user to accomplish.

This integration training module is not intended to train a user thoroughly in each

of the programs. The software reference manuals can be used to expand knowledge of

each of the programs to specific desired levels of expertise. The integration training

module's purpose is to outline and clarify the necessary steps to integrate the programs.

Background of the Study

Rapid growth is predicted for computer-based tools for art, design, and production in

graphic design studios and advertising agencies. Although moderate growth is currently

predicted for magazine usage, once color capabilities improve and color costs decline
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the magazine market will rapidly increase. These three groups have been traditionally

slow to make the initial investment, but as more of their competition incorporate

electronic tools the remaindermust do the same in order to remain competitive. The

DAVIS REVIEW anticipates that within the next two years, enough studios and agencies

will be using electronic equipment that the remainder will quickly do the
same.1

Desktop capabilities have reached a point of sophistication where page layout

programs can be linked to high end prepress systems.2 This reduces the amount of work

that is sent to traditional service bureaus for typesetting, and to prepress houses for

separation, cropping, media placement, stripping, and scaling. Keeping this work
in-

house can represent considerable cost savings and faster turn around time for design

studios and advertising
agencies.-^ The economics of incorporating electronic design

tools can be compelling for the reasons listed above.

These computer design stations require extensive training of personnel. If proper

training is not included with the equipment, it is possible the equipment will stand idle

while work is resumed in the traditional manner. It is not cost effective to have graphic

designers utilizing typesetting service bureaus and doing mechanical paste-ups to make

page layouts camera-ready when the investment in the electronic tools has been made.

Consequently, training is important for firms investing in computer design stations.
->

For the types of publications produced by graphic design studios, advertising

agencies, and magazines, training in five different areas is recommended by the author.

Area 1 Word processing program training

Area 2 Artwork program training

Area 3 Graphics program training

Area 4 Page layout program training

Area 5 Integration training

Areas 1 through 4 include training for the page layout program and the programs

that regularly import files into
page layout programs. These are artwork (draw/paint)



programs, graphics (scanning/image editing) programs, and word processing (straight

text matter) programs. The fifth portion of the training program (integration training) is

training the user to successfully bring text, artwork, graphics, and a page layout program

together. This integration training module will be the module in this proposal.

The software manuals and/or tutorials that are available for the individual programs

(Areas 1 through 4), are packaged by the software manufacturers as reference and

training tools. When using these tools the author found them to be adequate formost

situations. It was not confusing to go through one program on the Macintosh, using its

accompaning reference manual.

However, this user found progress halted many times when attempting to integrate

files, particularily files involving scanned images. During the course of several projects a

variety of image types needed to be imported into a page layout program. Some of the

problems encountered were: imported images became fragmented and reassembled

haphazardly, line detail in graphs was broken up, artwork disappeared, and files to be

imported could not be opened.

To troubleshoot these situations was frustrating. The information was spread out

over several manuals, making it confusing and accessibility difficult. In addition, the

program manuals tend to assume more than entry level knowledge of computer

vocabulary when discussing importation. The solutions to the problems this author

encountered were not always successful. Results were usually obtained by trial and error.

By having the key elements of integration in one volume, users attempting to layout

and/or design a publication using these programs will be able to proceed quicker with

less frustration. Each stage of integration will be explained for a user who is not

particularily computer literate. Since files may originate at other sources, this will aid the

graphic designer or art director in specifying the formats that are compatible with their

computer network, avoiding delays and complications.
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Scope of the Study

It is necessary to specify programs for the integration training module since different

programs have different requirements for integration. The following programs are

selected for their popularity, extensive use, and technical competence.

QuarkXpress page layout program

Adobe Illustrator artwork program

MC View Plus II graphics program

MacWrite word processing program

QuarkXpress currently holds the prominent position in page layout programs of the major

programs considered, such as Ready, Set, Go! and PageMaker because of its precision

and extensive user-defined typesetting capabilities. An expanded version is also capable

of linking to high-end resolution (Scitex) through a proprietary format called
Visionary."

Adobe Illustrator Although many draw and paint programs are available, Adobe

Illustrator was chosen because of its popularity in design studios, longevity in the

marketplace, and its relatively powerful functions and accuracy.
'

MC View This program is available for use in the Goudy laboratory. It enables the

user to scan a variety of black and white images for editing using the AGFA Focus

flatbed scanner. Images may be imported into Adobe Illustrator to be used as templates

for artwork, or directly into QuarkXpress as completed images. This integration training

module addresses the importation into QuarkXpress.

MacWrite MacWrite has been selected for the word processing program because

of its widespread use, ease of use, and
popularity.

Audience of the Study

This project is primarily targeted towards graphic designers who need to learn how to use

these new tools in a minimum amount of time. Other persons who would be likely to

benefit from this type of training module are new entries to desktop publishing, students,
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and occasional users of the equipment, such as temporary and part time employees.

The module's use is initially restricted to facilities utilizing the programs and

equipment selected for this project. In particular, users of the Macintosh network in the

School of Printing Management and
Sciences'

Goudy Laboratory will find this module a

helpful resource.

Although this module is specific in its program and selection, the format is such that

information for other software programs may be substituted to accommodate various

combinations of programs. Therefore it is possible to expand its use by creating revised

editions, with more research and experimentation. The revised editions would be

technically specific for other programing needs but much of the information would

remain constant.

Reasons for Student Interest

Electronic publishing has brought design and production, once treated as separate

entities, closer together. This technology is eliminating many manual steps of the

publishing process and will continue as technology becomes more
advanced.^

Currently

these electronic tools offer prepress production capabilities for design, but do not yet

have the technical capabilities in color to be feasible for full color print production.

However, as the technology improves, the color limitations of desktop tools will

decrease, eventually allowing acceptable design and full color production
services.^

The research and writing of this training module will be of benefit by expanding the

author's knowledge of the links, limitations, and possibilities in the current software and

equipment. This will be a foundation on which to better understand the technology as it

advances in the prepress area.



PROCEDURES

Methodology

This project is comprised of two components. The first and major phase of the project is

the experimentation, research, and writing of the integration training module. The second

portion is the evaluation and subsequent revisions.

1.) The Integration Training Module

Assumptions for the module

Selection of images and creation of files

Research and experimentation

Write module

2.) Evaluation of the Integration TrainingModule

Selection of judges

Evaluation by judges

Analyzation of evaluations

Revisions

The Integration TrainingModule

The final product will be an integration training module in the form of a reference

manual. The Quick Reference Chart (Figure 1 on page 2) will accompany the training

module. The basic outline of the book will follow the sample table of contents displayed

in Figure 2 (pages 8-10). Each chapter will include a short explanation of the basic

concepts of that chapter. The step-by-step sequence of the keystrokes will be included, as

well as diagrams necessary to illustrate what is occurring on the monitor. Experimentation

and research will determine the specific contents and instructions for each chapter.



ORGANIZATION OF INTEGRATION TRAINING MODULE

Table of Contents

List of Equipment and Software

List ofData Files and Images

List of Figures

Quick Reference Chart

Introduction to Publishing

Traditional Publishing flow chart showing traditional production path

Desktop Publishing flow chart showing production path utilizing electronic

publishing capabilities

Introduction to Integration TrainingModule

Purpose of the Training Module what it is trying to accomplish for the user

Assumptions Questionnaire knowledge user needs to proceed

QuarkXpress The Page Layout Program

Importation of Text from MacWrite The Word Processing Program

Location of Files recognizing the icon, where to look for the files, what is

included in the files such as; text only, text and formats, or tagged text

Format for Integration saving format

Considerations what needs to be addressed before importation or what can

be or is handled better by QuarkXpress

Importation ofArtwork from Adobe Illustrator The Artwork Program

Location of Files recognizing the icon, where to look for the files, what is

included in the files such as; artwork, preview artwork, artwork and

preview artwork, PostScript or bitmapped information

Figure 2 Sample Table ofContents for the Integration TrainingModule



Format for Integration saving format

Considerations what needs to be addressed before importation or what can be

or is handled better by QuarkXpress, such as scaling, rotating,

and othermanipulations

Importation of Scanned Images from MC View Plus II The Graphics Program

Location of Files recognizing the icon, where to look for the files, what is

included in the files such as; outline or bitmapped information, original

scan or user revised scan

Format for Integration saving formats

Line Art

Continuous Tone Image

Halftone Image

Halftone Diagram

Scanning Considerations what needs to be addressed before importation or

what can be or is handled better by QuarkXpress, such as scaling, rotating,

and other manipulations

Preparing for Output

Location of Files recognizing the icon, where to look for the files, what is

included in the files such as; have the imported files become Quark

files, where are the artwork and graphics residing, will they transport as

previews or at full resolution

Floppy Disk

Hard Drive

Portable Hard Drive

Figure 2 (cont'd)
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Format to Export

Low End Resolution Laser Printer

Linotronic

High End Resolution Scitex Connection

Troubleshooting Guide collection of some of the experimentation problems, mistakes a

user could easily make, and solutions to these occurances.

Glossary

Index

Figure 2 (cont'd)
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Assumptions

Since the purpose of this module is to provide instruction for importing text, artwork, and

graphics files into a page layout program, users do not need extensive knowledge of the

imported programs. Often files originate elsewhere, created by other sources. Minimally,

the graphic designer only needs to import these files into the page layout program.

Therefore, assumptions have been made of levels ofMacintosh literacy and program

competence in order to focus only on the integration aspect of the training program.

The author assumes the user has enough knowledge ofMacintosh to recognize

applications, windows, and menus. Basic knowledge ofMacintosh programs should

include opening, saving, and closing files.

A more extensive knowledge of QuarkXpress is required. Requirements include the

basic Macintosh functions listed above, understanding of page setup, the QuarkXpress

toolbox, text boxes and linking of text boxes, and picture boxes.

A list of user requirements is included in the module to determine if the user needs

more background knowledge before proceeding with the integration manual (Figure 3,

page 14). The user should refer to the manufacturer reference manuals that accompany

the software if it is necessary to review or acquire more information.

Selection ofImages and Creation ofFiles

All of the images will be black and white or have spot color. Process four color images

will not be addressed in this module. The following types of images will be imported into

QuarkXpress since each has different requirements.

Computer-generated artwork

clip art from Adobe Illustrator

Scanned images (on AGFA Focus flatbed scanner)

Line art

Continuous tone image
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Halftone image

Halftone diagram

The text and images that will be imported into the publication will be found in the

following files. A MacWrite file will be created for the straight text matter to be

imported. A clipart file will be created in Adobe Illustrator to be used as the computer-

generated artwork. The remainder of the images will be scanned on the AGFA Focus

flatbed scanner into MacView.

Evaluation of the Integration TrainingModule

Once the training module is completed, a panel of five judges will be asked to integrate

files into QuarkXpress by following instructions of the integration training module. The

judges will be selected from students in the School of Printing Management and Sciences

and graduate students in the College of Fine and Applied Arts. These judges will have

the basic knowledge required to use the module (ascertained by the user knowledge

questionnaire), but will not be particularily Macintosh literate.

After using the integration training module to integrate files, the judges will evaluate

the module by completing a questionnaire designed to evaluate the module for accuracy,

clarity, ease of use, and usefulness (Figure 4, pages 15-17). The intent of the questions are

listed below.

Question 1 Its function is to determine if the material is accurate.

Question 2 The intent of this question is to determine if the language is at the

user's level. The module must be easy to read and the instructions clear.

Question 3 Its primary function is to see if the module is organized in a manner

that makes it easy to use and access informtion.

Question 4 This question elicits information of the usefulness of this module as a

training tool. It determines if it will be used or become another manual on the shelf.

Question 5 This question takes question 4 a step further and tries to determine if
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the information is useful enough to customize it for specific customer needs.

Question 6 It addresses the concerns of training time. It is useful to know how

quickly a user can successfully use the module.

Question 7 & 8 These questions are to determine the user's level of expertise.

Question 9 This is designed to elicit responses from the users on the ways the

module may have been of use and suggestions on how it could be improved.

The images created for the experimentation portion of the project will be the images

provided for the panel of judges. However, future users of this module will be providing

their own images to use for their own publication. In the complete training program, as

users proceed through each of the programs, files will have been created for integration.

The list of text and images at the beginning of the manual will be a guideline of the tools

necessary to go through an entire training program.

The final portion of the project will include an analyzation of the results of the

questionnaires. Adjustments to the training module that will enhance its usefulness,

further clarity, and ease of use will be implemented.
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User Qualifications for the Integration Training Module

To determine if you need more training before using the Integration TrainingModule,

read the following list ofMacintosh and QuarkXpress procedures. Users must be able to

recognize the terms and carry out the procedures listed. If any areas are unclearmore

training is necessary in order to successfully use the Integration Training Module.

Macintosh Knowledge Required:

Equipment: What is the monitor, keyboard, hard drive, disk drive, and mouse

Windows: Title bar, scroll bar, close box, zoom box, and size box

Procedures: Use ofmouse: click, double click, highlighting

Opening: Open disks, applications, and files

Saving: save to disk, save to hard drive

Closing: close file

Quitting: quit application, close disk, eject disk

QuarkXpress Knowledge Required:

Procedures: Page Setup: set page size, set all margins, select single or facing

pages, set columns and gutters

Toolbox: Crosshair tool, editing tool, text box tool, picture box

tool, text box linking tool

Text boxes: make and delete text boxes, move and scale text

boxes, select and deselect text boxes

Picture boxes: make and delete picture boxes, move and scale

picture boxes, select and deselect picture boxes

Figure 3 User Qualifications for the Integration TrainingManual
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The Integration Training Module Evaluation Form

Name:

Date: .

Please check one of five choices for each question: SAStrongly Agree,
AAgree,

N
Neutral/Unsure,DDisagree, orSDStrongly Disagree

SA A N D SD

1. The instructions were not accurate. Results |
~~

1 I I I I I

achieved were different from those in the

module. Which instructions were not accurate

and explain what happened. Please do not

include slight variations in dialogue boxes

which may occur between different versions of

the same program.

The instructions were clear and easy to follow. QJ] f | j
'

List any instructions that were ambiguous and

explain how they were unclear.

Figure 4 The Integration TrainingModule Evaluation Form
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The organization of the module and the

sequence of the material was logical, making it

easy to use. Comments, if any, to improve the

organization of the module.

SA A N D SD

? ? ? ? ?

4. If your company were using these programs,

this module would not be a valuable reference

and training source. It would not be used

frequently.

5. If your company were using other programs,

would you like to see a version of this training

module custom made for those programs?

6. Approximately how many hours did it take you

to complete the training module?

7. Before using this training module my computer

experiences involved the following types of

programs:

(select as many as applicable)

none

word processing

draw/paint

page layout

other describe

Approximately what percentage of the

procedures outlined in this module could you

accomplish before using this module?

none

0-25%

25-50%

50-75%

75-100%

Figure 4 (con't.)
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Please make comments on the advantages or disadvantages of the training module and its

usefulness. Is there anything you would change or handle differently?

Figure 4 (con't.)
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Equipment, Laboratories, andMaterials

Equipment andLaboratories

Access to the Goudy laboratory, with its Macintosh network will be necessary for this

project. The following equipment from the Goudy laboratory will be needed:

Macintosh IIx

AGFA Focus flatbed scanner

Laser output devicesAGFA P3400 PS

Varityper VT600W

Portable hard drive

Software

QuarkXpress page layout program

Adobe Illustrator artwork program

MC View graphics program

MacWrite word processing program

Images and Text

Computer-generated artwork

clip art from Adobe Illustrator

Scanned images (on AGFA Focus flatbed scanner)

Line art

Continuous tone image

Halftone image

Halftone diagram
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RESULTS OF THE PROJECT

Desirable Attributes Relative to the Purpose

The stated purpose of this thesis project is to develop a training module to integrate text,

computer-generated artwork, and scanned graphics into a page layout program. The

following characteristics are desirable for this training module:

1 . Location of information The information necessary to successfully import

files must be contained in one source, The Integration TrainingModule.

2. Accuracy Users must achieve the same results as the author when following

the instructions in the module.

3. Clarity The information must be written at the level of the targeted user. The

audience is a relatively unsophisticatedMacintosh user and is unskilled in using

systems for preparing mechanicals.

4. Organization The format must allow quick and easy accessing of information.

5. Effectiveness The module must be considered a useful resource by the users.

6. Training time The users must be able to proceed quickly through the module.

7. Format of the module The format must be adaptable so that the module may

be customized for other programs without difficulty.

User Responses to The Integration Training Module

Analyzation of the Integration Training Module Evaluation Forms (Figure 4, pages 15-17)

show the IntegrationModule to generally be a success. The responses to the questionnaire

are compiled in chart form in Figure 5 (page 20). Better than average or excellent

responses were found for 22 out of 25 rated responses from questions 1-5.
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Results of the Integration Training Module Evaluations

Synopsis ofQuestions User Responses

User #1 User #2 User #3 User #4 User #5

Question 1:

Accuracy of instructions

D SD D D SD

Question 2:

Clarity of language

A SA A SA

Question 3:

Organization ofmodule

A SA SA SA

Question 4:

Effectiveness of this

module

D SD D N SD

Question 5:

Desirability of

customized modules

A SA A SA SA

Question 6:

Trainng time in hours

1.5 1.75 1.5 1.5 1.5

Question 7:

User expertise

familiarity with similiar

programs

draw/paint,

page layout

all, plus

scanning

all, plus

scanning

all, plus

scanning

all

Question 8:

User expertise

percent of functions able

to accomplish before

using module

25-50% 75-100% 50-75% 50-75% 0-25%

User Comments well

organized,

suitable for

low level

users only

well

organized,

clearly

written

desired in

depth

technical

information

desired

more

detailed

scanning

information

organized,

liked

graphics,

liked

trouble

shooting

section

Figure 5 Results of the Integration TrainingModule Evaluation Forms
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Accuracy and Clarity

Questions 1 and 2, dealing with accuracy and clarity, yielded high responses by four of the

five users. User #4 disqualified himself for question 2, concerning clarity of the instructions,

because he was familiar with Quark and did not need the "How To
Import"

instructions.

Two of the users were extremely pleased with the instructions. User #2's comment

was, "Directions were very clear and precise. It brought complex actions and terminology

down to basic, easy-to-follow
instructions."

User #5 especially liked the extensive use of

graphics accompanying the instructions.

The other two users found no major problems with the instructions, but had several

suggestions to improve clarity. User #1 suggested including directions to draw a picture

box before activating a picture box, although it was not suggested to draw a text box before

importing text. User #3 thought it would be wise to remind users at the beginning of each

chapter that QuarkXpress is the page layout program. Two of the charts also needed

clarification.

Organization

The organization of the module was a particularily successful attribute. Each chapter

discusses a different type of file or image to be imported. Each chapter is designed to stand

on its own so users do not need to access information from other chapters. Although this

format causes some material to be repetitive, users do not need to read the module from

beginning to end in order to import a specific type of image. User #1 stated, "The

repetitiveness also allows each section to be a manual on its own. Therefore, one section

does not have to be completed before
another."

Each chapter is divided into distinct sections. A summary of the save formats, "How

To
Save,"

is first, followed by the "How To
Import."

The more technical information,

explaining the processes and formats, is contained in "Hints: What Has
Happened."

A

troubleshooting section, "Hints: What To Look
For,"

is at the end of each chapter.
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The organization of the chapters makes the module work on two levels. Beginners

appreciated that they could get in and out of the module very quickly by using the "How

To"

sections. This is suited for the user who has no interest or time to spend on the

technology. However, users wanting a more technical understanding had that information

available to them. User #2 states, "The basics came first and more technical information

followed for the user to read if needed. Therefore all necessary information was located at

the start of each chapter. This organization made it extremely simple for me to find the

information I needed and not get bogged down in technical details. I read those after

completing the
exercise."

Question 3 was not rated by User #4. However User #4 suggested that the chapter

on importing halftone charts, graphs, and diagrams follow line art, since the procedure

recommends using line art methods. Since the original image is a specific type of halftone,

the chapter remains in its initial location, following the chapter for importing halftones.

Effectiveness

Questions 4 and 5 elicited responses on the usefulness of the module. Out of ten possible

responses, one was neutral, four were better than average, and five were excellent. User #4

was neutral about the usefulness of this particular module (question 4) because he was

fairly proficient in using the programs and equipment before reading this module. However

he felt a customized version for specific work situations (question 5) was an excellent idea.

Training time

The training time for all of the users was virtually identical, regardless of the
users'

backgrounds and previous experience. This supports the responses that the instructions are

accurate and clear. Since the beginners were able to complete the identical set of exercises

in the same time frame as the more experienced users, it indicates that time was not lost by

incorrectly interpreting instructions.
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The 1 .5 hours needed to complete the exercises is considered a reasonable amount

of training time by the author. This was the amount of time needed by the five users to get

in and out of the "How
To"

sections for scanning and importing files. Although reading the

technical information adds to the training time and the knowledge of the user, it is optional

reading and not necessary for the user who needs only to import quickly. The time factor

also supports the favorable responses to the organization of the module.

Format of the module

The organization of the module was designed to simplify customizing for specific

programs and scanners. By dividing the chapters into sections as explained under

Organization (page 19) much information can be retained with virtually no changes.

Required changes would be found primarily in specific sections.

The "How To
Import"

and "How To
Save"

information is separate from the

technical information. Many of the changes necesary when changing programs would be

restricted to the "How
To"

sections.

Most of the technical information in the "Hints: What Has
Happened"

sections are

conceptual and deal with standard save formats and their attributes. This information will

not change from program to program.

Many of the troubleshooting problems found in "Hints: What To Look
For"

would

remain constant because of the characteristics of the save format selected, especially if the

page layout program remained the same. However if the page layout program is changed,

then some of the information would remain constant, but other examples would need to be

altered to suit the specific selected programs.

The basic skeleton is a good one judging from the user responses. It is not

anticipated that problems would occur trying to convert this skeleton to other applications.
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User Levels ofExpertise

Five students were selected to complete a series of exercises using the instructions in the

module and then to answer the questionnaire. Two of the five users (Users #1 and #5) had

no previous experience working with QuarkXpress or the Agfa scanner, but had worked

with other programs at a beginner level. The other three users had some working

knowledge of QuarkXpress and the Agfa scanner.

Users #2 and #5, the most experienced and the least experience users, gave the

module the highest ratings. Both made very positive comments about the organization of

the module. The organization was the key factor that made the module work well for them.

The basics of scanning and importing are relatively simple. The aim of the module was to

clarify the bewildering array of choices and offer basic technical information without

exceeding the users levels. In this regard the module was a success for User #3, who

appreciated having the basic technology explained. However both Users #3 and #4 would

have liked more depth to the technical information.

Suggestions for Improving The Integration Training Module

The language and liberal use of graphics are intended to guide non-sophisticated users

through the integration process. Although technical information is included for the user who

wishes to expand his knowledge beyond the basics of "How To", it may not be enough for

a more accomplished user or a user who wants a quantity of technical information. The

technical information provided in the module is written for the understanding of non

technical users. The module is simplistic for users who have progressed beyond the beginner

stage. To appeal to a wider audience the technical information could be expanded further.

The more advanced users suggested that information on optimizing scanning be

included. This module explains the basics of the scanning process and the basic choices

users must make when in the scanning program. The inclusion of hints on how to get the

optimum scan would be a valuable addition and enhance the usefulness of the module.
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Problems Encountered

The original plan of the author was to recommend a save option for each type of image and

to illustrate how to import these images into Quark. However, it became evident that the

selection of a save format was not the only crucial choice when preparing a file for

importion. The save format selections offered to the user are dependent upon the scan

output option selected prior to scanning. To select the proper scan output a number of

variables must be taken into consideration first. The user should consider the resolution of

the output device, whether or not viewing the image on the monitor is necessary, whether

or not the ability to modify the image after it is saved is necessary, and whether or not the

ability to modify it after it is imported is necessary. Therefore, the scanning process and its

options played a much larger part in the development of this module than originally

anticipated.

The author made a concerted effort to discuss only the crucial choices that affected

the save formats and importation in order to keep the module true to its original purpose

and not to overwhelm the target audience. The scanning program offers many options and

tools not discussed in detail in this module. How to get the optimum scan becomes the next

question of the more accomplished user and is really beyond the scope of this module.
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CONCLUSIONS

Conclusions

The Integration TrainingModule is suitable training tool for its target audience at two

levels. Beginners found the module easy to read and understand, and appreciated the

organization that separated the technical information from the instructions on scanning,

saving, and importing. Some users will not want to progress beyond the basics of

accomplishing the "How
To"

instructions. Others will eventually desire the more advanced

and technical information that is available. By segregating the instructions and technical

information the module appeals to both types of users.

The module has possibilities for being customized for specific work situations. It

could be revised to display instructions for other major page layout programs and/or other

scanners with their accompanying software. Many users only want to get in and out of a

system quickly. Customizing this module would allow those users to accomplish their

work quickly with no guesswork. This module could be used as a prototype for producing

a series of training modules to accompany page layout software or scanner software.

Value of the Project

The Integration Training Module is a good training and self-teaching tool. The instructions

to import into QuarkXpress are easy to learn. The real value of the module is the pulling

together of the technical information that explains what has happened in the scanning

program, what has happened during the import to the page layout program, and how these

elements work together. Information about the scanning program, page layout program, the

attributes of the scan outputs, and the attributes of the save formats which had been

dispursed among various training manuals and periodicals is now located in one volume.

This module is particularily suitable for self-training in the School of Printing, since it is
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software and equipment specific to that facility.

Many changes in the software will occur in the future, however, much of the module

is conceptual information explaining the scanning process and the nature of the save

formats. This type of information should not change in the immediate future. Therefore,

although specific instructional information will change with each software revision, the

basic technical information will be of value beyond those changes.

Recommendations for Future Projects

The logical next step for study would be experimentation in how to optimize scanning. The

author found that the basics of scanning needed to be included in this module. However,

experimentation and information on how to get the optimum scan was really another

subject in itself. In addition, two of the more advanced users of this module requested more

information on this subject. A study experimenting with type of image, type of scan, and

type of output device would be a good compliment to this module.
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MacWrite

I

Adobe Illustrator

Word Processed Text

I
MacWrite Modifications

available before save

I

I
Type of Image:

Computer-generated

Artwork

Select Save or Save As

I

I
Illustrator Modifications

available before save

I

MacWrite Modifications

available after save

Save As: EPSF

Closed file is ready

for Quark to import

I
Illustrator Modifications

available after save

Closed file is ready

for Quark to import

Quark Modifications

all available

Scale Quark Modifications

Duplicate

Step and Repeat

Shaded boxes indicate

selections crucial for

Quark importation
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MC View Plus II

I
Type of Image:

Line Art

or Shaded Diagrams

I
Select Line artOutput

MC View Modifications

available before scan

adjust Threshold for original

match resolution to output

device

Scan

If MC View modifications

are required,

or

if Quark Style menu

modifications are required,

or

if laser printer output

Save As: TIFF

Uncompressed

MC View Modifications

available after save

Closed file is ready

for Quark to import

Quark Modifications

all available

MC View Modifications

available after scan

add shades and patterns to

diagrams with Pattern menu

andpaintbucket tool

I
Select Save Format

Color

t

Shade

I

Scale

i

If no MC View

modifications are required,

and

if no Quark Style menu

modifications are required,

and

if high resolution output

MC View Modifications

before save only

Save As: EPSF

Closed file is ready

for Quark to import

Duplicate Quark Modifications

Negative Step and Repeat

Screen

Scale

i

Duplicate

i
~

Step and Repeat

Shaded boxes indicate

selections crucial for

Quark importation

Quick Reference Guide IX



MC View Plus II

If no modifications are required,

and

if laser printer output,

and

if monitor viewing not required

I

I
Type of Image:

Continuous Tones

or Halftones

I

Select Scanning Output .

HalftoneOutput

', Screen generated during scan

I
Descreen

if a halftone original

I
MC View Modifications
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Halftone Screen

I

Scale

I

Tone Compensation

I

Output Resolution

Scan

I

Save As: EPSF

I
Closed file is ready

for Quark to import

Quark Modifications Duplicate

Step and Repeat

Shaded boxes indicate

selections crucial for

Quark importation
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If MC View modifications

are required,

or

if Quark Style menu

modifications are required,

or

if laser printer output,

or

if monitor viewing is

required

_L

Save As: TIFF

Uncompressed

I
MC View Modifications

available after save

must select Proofprinter

screen forMC View

printing

Closed file is ready

for Quark to import

Quark Modifications

all available

must select screen for

Quark printing

Ifmodifications are required,

or

if high resolution output,

or

if monitor viewing required

I
Contone Output

PostScript screen generated

during scan

I
Descreen

if a halftone original

I
MC View Modifications

available before scan

I
Scan

MC View Modifications

available after scan

I

Select Save Format

If no MC View

modifications are required,

and

if no Quark Style menu

modifications are required,

and

if high resolution output,

and

if monitor viewing not

required

MC View Modifications

before save only,

musf select EPSF screen

Color

x

I

Save As: EPSF

Shade

"T

I
Closed file is ready

for Quark to Import

Negative

m

Contrast

Screen

Scale

i

Duplicate

Scale

i

Duplicate Quark Modifications

Step and Repeat Step and Repeat
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Introduction to Publishing

Publishing Production Processes

Traditional In the traditional production process many of the prepress

Production functions are manual and involve numerous steps in

Process several departments. Figure 2 (page 2) shows the path of

a typical traditional production sequence.

Line copy requires professional typesetting, usually set at

service bureaus. Editing and revisions will be returned to

the typesetter until the copy is satisfactory. Thumbnails

of the layout and copyfitting of the text is done manually

by designers. The typeset copy and line art is pasted-up
to designer specifications by mechnical artists.

Once the mechanicals are ready, line negatives are shot

by the camera department. The camera department

prepares halftone and separation negatives of continuous

tone and color images separately from line negatives.

The line negatives and halftone/separation negatives are

then assembled by the stripping department. Proofing of

the assembled page can be done only after stripping.

Electronic Electronic publishing is versatile and efficient. Many
Production prepress functions can be accomplished at a single work

Process station. Shaded boxes in Figure 3 (page 3) display stages

ofproduction that can be handled by an electronic system.

The electronic system not only allows designers to

experiment with layouts and type quickly, but editing,

typesetting, copyfitting, and computer-generated artwork

can be done in-house on the same system. By generating
halftones and separations electronically, the camera

work can be done in one step. Image assembly has been

done electronically, so stripping is not necessary. Changes

can be made at any time before the negatives are shot

and assembled pages can be proofed at any time.
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The Traditional Publishing Production Sequence

Line Copy

Text

Write

Edit

Typeset

Proofread

Line Art

Publication Concept

Layout and Design

Mechanicals

Manual paste-up

Line Negatives

Tonal Copy

Photographs,
Artwork

Camera

Halftone/separation

negatives

Flats

Manual stripping

Proofs

Platemaking

Press Sheets

I
Finished Publication

Figure 2 The Traditional Publishing Production Sequence 1
>
2
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The Electronic Publishing Production Sequence

Publication Concept

Line Copy

Word

Processed

Text

Write

Edit

Proofread

Import into

page layout

program

Page Layout

Program

Line Art

Scan art

Import into

page layout

program

Mechanicals

Electronic paste-up and

electronic stripping

Tonal Copy

Photographs,
Artwork

Scan images

Electronic halftones

import into page

layout program

Electronic Separations

Negatives

Proofs

Platemaking

Press Sheets

I
Finished Publication

Shaded boxes indicate

electronic manipulation

or generation.

Figure 3 The Electronic Publishing Production Sequence 3> 4
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The Integration Training
Module

Purpose of the Training Module

The purpose of this training module is to guide users

through the essential stages of importing text, computer-

generated artwork, and scanned graphics into a page

layout program. Previously the information for successful

integration had to be referenced from several sources. By

having the key elements of integration in one volume,
users attempting to layout and/or design a publication

using the specified programs will be able to proceed

quickly with a minimum of technical problems.

This integration training module is not intended to train

a user thoroughly in each of the programs. The software

reference manuals can be used to expand knowledge of

each of the programs to specific desired levels of expertise.

This module's purpose is to outline and clarify the

necessary steps to integrate the programs.

Format of the Training Module

The Integration TrainingModule has threemajor sections.

The two introductory chapters provide background

material and preparation information. The following six

chapters deal specificallywith integration and are

labelled by the software program used and the type of

file to be integrated. Each of the six integration chapters

are intended to be complete in themselves, so that users

do not need to build knowledge from preceding chapters.

Users may go directly to the chapter which deals with

their specific type of image and follow the sequence of

saving and importingwithout referring to other chapters.

The final chapter provides important information on

output of the integrated documents. A glossary and index

are found at the end of the module.
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Chapter

Organization

Save Format for

Integration

The chapters addressing integration are broken down

into five or six sections. The sections are:

Save Format for Integration

How to Save inMC View Plus ( if a scanned image)

How to import

Hints:What Has Happened

Hints: What To Look For

Considerations: Before and After Importation

This section simply states what save format the file should

be in before it is imported. This allows the user to specify

to outside sources the preferred save format. If the

application is available the user may open the file to

check the saved format. Some incorrect save formats may

be changed to correct save formats, but if the original

formats save less information than the correct formats,

then essential information has been lost.

How to Save in

MC View Plus

Saving an image in MC View is not one simple save

function. Save format choices are dependent upon other

choices and considerations the user must make. This

section covers the major selections a user will face when

scanning and saving to have an image ready for

importation into Quark. Although it is not intended to

review the entire scanning process and options, it

highlights the crucial choices.

How to Import

Hints: What Has

Happened

This section is a keystroke by keystroke sequence of how

to import the file into the page layout program. Graphics

have been liberally used to illustrate the process.

These hints are for the user who wants to know more

than just the keystrokes. Short, easy to understand

explanations ofwhat has happened are included to

provide a basis for understanding the process. This

information is valuable when the need for

troubleshooting arises.

Hints: A troubleshooting section is included with each chapter.
What To Look For Examples of common importation problems are included

along with brief explanations ofwhat is wrong and the

solutions to the problem.
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Considerations:

Before and After

Importation

Although each of the programs used in this module are

specialized, some of the tools and functions are the same

or handle similiarly. When importing files from programs

that have overlapping functions, the user must make

decisions in which program to address these functions.

This section examines which functions overlap and which

program is the better choice for handling each of the

overlapping functions.

Assumptions

Vocabulary In order to simplify the vocabulary of this module several

frequently used terms have been shortened. The term

module refers to this integration training module, while

reference manual or manual indicates manufacturer

reference manuals that accompany original software. For

ease of use, Adobe Illustrator is Illustrator, MC View

Plus is MC View, and QuarkXpress is simply Quark.

Definitions of terms used in this module are found

alphabetically in the glossary at the end of the module.

Scope It is necessary to specify programs for the integration

training module since different programs have different

requirements for integration. The following programs are

selected for their popularity, extensive use, and technical

competence.

QuarkXpress 2.12 page layout program

Adobe Illustrator 88 artwork program

MC View Plus II scanned graphics program

MacWrite 5.0 word processing program

All of the images are black and white, but could have

spot color. Process four color images are not addressed in

this module.

User Knowledge Since the purpose of the module is to provide instruction

for importing text, artwork, and graphics files into a page

layout program, users do not need extensive knowledge

of the imported programs. Many times files originate

elsewhere, created by other sources. Minimally, the user

only needs to import these files into the page layout
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program. Therefore, assumptions have been made of

levels ofMacintosh literacy and program competence in

order to focus only on the integration aspect of files. A

simple listing of the necessary knowledge is provided

under User Qualifications.

User Qualifications for the Integration Training Module

To determine ifmore training is necessary before using

the Integration TrainingModule, read the following fist

ofMacintosh and QuarkXpress terms and procedures.

Although only a basic knowledge ofMacintosh is

necessary, a more extensive knowledge ofQuarkXpress is

required. Users must be able to recognize the terms and

carry out the procedures listed. If any areas are unclear

the user should refer to theirMacintoshmanual or

QuarkXpress reference manual to review or acquire more

information.

Macintosh Equipment: What is the monitor, keyboard, hard drive,
Knowledge disk drive, and mouse

Required

Windows: Title bar, scroll bar, close box, zoom box, and

size box

Procedures: Use ofmouse: click, double click, highlighting

Opening: open disk, applications, and files

Saving: save to disk, save to hard drive

Closing: close file

Quitting: quit application, close disk, and
eject disk

QuarkXPress Procedures: Page setup: set page size, set all margins,
Knowledge select single or facing pages, set columns
Required and gutters

Toolbox: crosshair tool, editing tool, text box

tool, picture box tool, text box linking tool,
and text box unlinking tool
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Text boxes: make and delete, move and scale,

select and deselect

Picture boxes: make and delete, move and

scale, select and deselect

Introduction to the Integration Training Module
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Importing Text from MacWrite:

Word Processed Text

Save Format for Integration

Save is the only choice thatMacWrite offers. Save As is

the same format.

How To Import Text into QuarkXpress

Select the editing tool from the tool palette and click.

The selected tool will become a negative
image.5

W

Activate text box with a single click of the
mouse.6

-- '

Select Get Text under the File Menu.

Get Text can only be selected if a text box

and the editing tool are
activated.7

I~ File Menu
Neiv_ xn

Open... XO

Close

Save XS

Save as...

Reuert to Saved

Get Tent... XE

Save Text _.

Get Document

0.nlrmt f~~.ot Toyt

Page Setup

Print XP

Transfer... XT

Quit XQ

The Get Text dialog box will appear.

Ifyou are in a file, it lists the files and folders that

can be imported into Quark from the location
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(hard disk or floppy disk) where you opened this

file. If you are in a folder at either location, it lists

the files in that folder.8

A double click on a folder name will open that

folder to show you its folders or file names. Folders

can be inside folders so double click until the

desired file is found.

Dialogue box name

Folder on hard drive

File inside folder

(double click to

import)

Folder inside folder

(double click to

display files)

Locatio

Do not use for

MacWrite

To change location, a single click on the
"drive"

button will transfer you between the disk and the

hard drive.

Convert Quotes is automatically selected.

It converts
'

and
"

to
' '

and
"

". If the file has many

measurements in inches and feet, then the Convert

Quotes may be deselected by a single click.
9

Select the desired file for text importation.

A double click on a file name will import the text

from that file into the activated text box.

A single click on a file name, then a single click on

the
"open"

button will also import the text.

The text box from the Quark document should now be

displayed with the imported text in place.

Hints: What Has Happened

When Quark "gets
text"

from the selectedMacWrite file

it imports all the text and text formats from that file.
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However graphics are not imported with this function. If

theMacWrite file has graphics within it (such asMacPaint

orMacDraw graphics), theymust be addressed separately

using the Get Picture function, the Clipboard, or the
Scrapbook.10

Text Overflow Since text is poured into text boxes, it flows to fit the size

and shape of those text boxes. If the MacWrite file is

imported into a text box that is part of a chain of linked

text boxes, the text will automatically flow from one text

box to another in sequence of the linkage. By using the

Auto Page Insertion option under Preferences in the Edit

menu, Quark has the capability to automatically add

pages to accommodate text overflow.11 The Quark

manual explains when this option may be used.

If the activated text box is not part of a text box chain, or

if the chain is not large enough to hold all of the text and

the Auto Page Insertion option is not in operation, then

Quark displays the Kl symbol to indicate that text

continues but is not visible.

Style Formats Quark has aMacWrite filter that allows the file to be

read directly. Therefore style formats incorporated in the

original document should be found in the Quark

document. However since the filters are not fully capable

of identical reading, proofreading is recommended
12 For

example, the filter does not read superscript from a

MacWrite file. Below are listed styles that should be

considered when planning a document.

Page style:

Margins TextAlignment

Headers Page break

Footers New line

Indents New paragraph

Tabs

Typographic style:

Font

Type style

Leading
Point size

Hyphenation (manual)

Word spacing

Character spacing
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Hints: What To Look For

Get Text Display IfGet Picture displays under the File menu instead of

Missing Get Text then:

A picture box is selected. Deselect the picture box

and activate a text box.13

IfGet Text is shaded instead of solid then:

The wrong tool is selected. Activate the edit
tool.14

MacWrite Files

Missing

If the desired MacWrite file does not display in the Get

Text dialog box then:

Use the Find File function found under the Apple

menu to locate the file. If the file is not found it

must be installed on the hard disk or the diskette.

To manually search for the MacWrite file, close the

Quark file and application. Search by looking for

the MacWrite icon with the appropriate file name

in the window.

If no MacWrite files display in the Get Text box then:

The Quark MacWrite filter is missing. Close the

Quark file and quit the application. Install the

Quark MacWrite filter in the Quark folder.

MacWrite icon MacWrite filter

Text Format

Problems
If text flow between text boxes is incorrect then:

Select the Linking tool to see which boxes are
linked and in what sequence. Correct by using the

Linking and Unlinking tools.

If text breaks within the text box then:

Go to the View menu and select Show Invisibles.

Look for New Lines, New Paragraphs, and Tabs.15

fJ New Lines IT New Paragraphs ^ Tabs

(manual returns) II

The tabs and returns are set for the fine length in

the original document. The text box in the Quark
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Font Problems

document has determined a new line length, result

ing in unsuitable breaks. Delete manual returns

and tabs that are undesirable. Ifyou are using a

specified style sheet for the QuarkXpress document,

apply the style sheet to the imported text before

deleting returns and tabs.

If the system you are using does not have the fonts that

were used in the original MacWrite file then the following
dialogue box will appear:

A
This document uses fonts not

installed in your System

(possibly
"

'%

The file will be imported but the specified font(s) will be

substituted on the screen and the output from that

system will be bitmapped. To prevent bitmapped output:

Install the specified font(s) into the system.

Substitute the original font selection with a font

that currently resides in the system.

If the system you are using has another version of a

font used in the original MacWrite file, then the following

dialog box will appear:

A
This document was built with other

uersions of some fonts. It will be

reflowed using this System's fonts.

When the file is imported the new font version will be

substituted for the original version, reflowing all of the

text according to the new font version. The reflowing can

make major differences in the copyfitting. However

output from that system will be in PostScript of the new

font version, not a bitmap. If this is not acceptable then:

Install the original font into the system.
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Considerations: Before and After Importation

Editing Text Text can be edited in both MacWrite and Quark, but it is

preferable to edit inMacWrite before importing. This is

especially true ifversatility is a
factor because edited

MacWrite files, carrying both text and formats, may be

imported into a variety of
programs.16 However edits

applied in Quark remain in Quark and do not go back to

the original MacWrite file. Although Quark text may be

exported with the edits by using the Save Text option,

only the text is saved and exported, not the page
format.17

Font Selection

and Type Style

Font selection is dependent upon the system that will be

doing the output, not the programs. Therefore, it does not

matter which program is used to make the font selection.

Fonts should be selected based upon which printer fonts

currently reside on the hard disk, or plan to install the

printer fonts on the hard disk before printing.

Typographic

Functions

One ofQuark's major advantages is its extensive

typographic functions which are user controlled. Quark

gives the user many typographic options not available in

MacWrite and with more precision. When setting up a

MacWrite file only basic typographic choices can be and

need be addressed. More extensive typographic choices

should be made in Quark to take full advantage of the

program's possibilities. A listing in Figure 4 (page 17)
gives the user a quick comparison of capabilities between

the two programs.

Saving in Quark When the Quark document is saved, text that has been

imported becomes part of the Quark document. The

output of the Quark document is not dependent upon the

MacWrite file residing on the diskette or hard disk.
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A Comparison of Typographic

Capabilities between MacWrite 5.0 and

QuarkXpress 2. 12

Typographic

Functions MacWrite

Point sizes 6 standard sizes

(9,10,12,14,18,24;

Size increments 16 pts

Reversed type no

Hyphenation

controls

no

Adjustable

leading

no

Leading
increments

line spacing single,

1 1/2, and double

QuarkXpress

Kerning

Tracking

no

no

Adjustable letter no

spacing

Adjustable word no

spacing

Baseline shift no

Font rendering no

Font Styles yes, but limited

2-500 pts

.25 pt

yes

yes

yes, absolute or auto

.001 pt

yes automatic, manual,

increments of .005 em,

kerning table access

yes increments of.005 em

yes

yes

yes

yes

yes, more choices

Figure 4 A Comparison ofTypographic Capabilities between

MacWrite 5.0 and QuarkXpress 2.12 18
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Importing Artwork from Adobe Illustrator:

Computer-generate

Artwork

Save Format for Integration

Select EPSF for

Macintosh

Adobe Illustrator files must be saved in the Encapsulated

PostScript (EPSF),Macintosh format. QuarkXpress

cannot read the other formats, including PostScript Only,
from Illustrator.19

Q Illustrations

Q Panda ail

D Panda template

? Uenus

5

o

>HD20

Eject

[ Dht'e ~)

Saue document as: Saue

Example art

3
( Cancel ]

O PostScript Only
-<S) Encapsulated PostScript (Macintosh)

O Encapsulated PostScript (IBM PC)

How To Import Computer-generated Artwork into Quark

Select the editing tool from the tool palette and click.

The selected tool will become a negative image.20

w

Create a new picture box or activate a current picture

box with a single click of the mouse.21

L^ m

Select Get Picture under the File Menu.

Get Picture can only be selected if a picture box

and the editing tool are
activated.22
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Wtfll -M

New... XN

Open.- xo

Close

Save xs

Saue as.-

Reuert to Saved

Get Picture

Saue Text

fret Document...

Page Setup-

Print.- XP

Transfer XT

ami xo

File Menu

Select Get Picture

The Get Picture dialog box will appear.

If you are in a file, it lists the files and folders that

can be imported into Quark from the location

(hard disk or floppy disk) where you opened this

file. If you are in a folder at either location, it lists

the files in that folder.23

A double click on a folder name will open that

folder to show you its folders or file names. Folders

can be inside folders so double click until the

desired file is found.

Dialogue box
name-

Folder on hard disk

Folder inside folder

(double click to

display files)

File inside folder

(double click to

import)

Location'

Save Format

To change location, one click on the
"drive"

button

transfers you between the diskette and hard disk.

-?Get Picture

Q File PlctT|

>Hard Disk

Driue ]

Open

Cancel

Size: 11 K

Select the desired file for artwork importation.

Its save format is displayed in the dialogue box.

A double click on a file name will import the

art from that file into the activated picture box.

A single click on a file name, then a single click on

the
"open"

button will also import the file.
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The picture box from the Quark document should now

be displayed with the imported art in the picture box.

The imported picture replaces any picture that was

previously placed in the box.

Hints: What Has Happened

The EPSF Import The appearance to the viewer is that the entire
"picture"

or artwork from Illustrator has been imported at the size

it was created in Illustrator. In actuality, EPSF creates

two formats, both formats are contained in one file, and

displayed by one icon when viewed on the desktop.

The first format is a PICT format, which is the
"preview"

picture seen in the picture box on the screen. This PICT

format file is used by Quark for placement, scaling, and

cropping. It is also the information which low resolution

non-PostScript printers (such as ImageWriters) use to

print. The PICT format has smaller memory requirements

and is saved with the Quark file after it is imported.24

This PICT portion of the EPSF file should not be confused

with PICT files. PICT files are created in draw programs

or scanning programs to be imported into Illustrator and

used as templates for artwork. They have separate icons

whereas the PICT portion of the EPSF file is contained

within that file and is not seen on the desktop.25

The second format of the file is the PostScript format.

This is the more accurate output printed by PostScript

printers. The PostScript information is not saved with

the Quark document, but is accessed from the original

Illustrator file when the Quark document is printed.26

Hints: What To Look For

Get Picture IfGet Text displays under the File menu instead of

Display Missing Get Picture then:

A text box is selected. Deselect the text box and

activate a picture
box.27

If Get Picture is shaded instead of solid then:

The wrong tool is selected. Activate the edit
tool.28
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Illustrator Files If the desired Illustrator file does not display in the

Missing from Get Get Picture dialogue box then:

Picture Display The file may reside in a
different folder or it may

not be resident on the hard disk or floppy disk.

Use the Find File function found under the
Apple

menu to locate it. If the file is not found then it

must be installed on the hard disk or diskette.

The file may be saved in the wrong
format. The

Get Picture dialogue box will only display files

that are in an accepted format for importation.

Find File will locate the file, but not display the

save format. Close the file and quit the application.

Go to the location (using Find File) and look for

the PS/Mac Illustrator iconwith the appropriate

file name in the window on the desktop. The

Illustrator icon displays an
"A"

or
"88"

depending

on the version. The * indicates the EPSF
format.29

S?i
A- 88

Adobe Illustrator Icons

Encapsulated PostScript, Macintosh

If the format is incorrect, a double click on the icon

will open the file so that the save format can be

changed (the application must be resident).

Blank Picture

Box on Screen

If the X inside the picture box disappears but the

picture box is blank then:

The picture has been imported but its visible

portions are not centered in the picture box. Use

96-shift-M to automatically center the picture

within the picture box.30

The edit tool may also be selected. The hand

portion of the tool will be activated and the picture

can be moved by
"shding"

it with the hand.31

Artwork Missing
on Screen

If after importing the EPSF file the followingmessage

appears in a gray shaded picture box then:

PostScript Picture

(title of file)
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The PICT format is too large for screen viewing and

has not been imported. The PostScript will be

accessed for output if a PostScript printer is used,

but the PICT portion of the EPSF file is not

available for screen viewing or bitmap output from

low resolution
printers.32

imported

Artwork Files

Modified or

Missing
(Output is

Bitmapped)

If the following dialogue box appears when attempting
to print then:

A
Some disk files for pictures in this document haue

been modified or are missing.

List Pictures ) | Print flnymay I [ Cancel Print )

Go to List Pictures to determine if the problem is

missing or modified pictures. Another dialogue box

will appear listing the file name of the artwork,
page location, format of the file, and the missing or

modified
status.33

Missing or Modified TIFF/RIFF/EPS Pictures

Name Page Type Status

EPS Logo

Paint Brush

Sunset.TIFF

I EPSF Modified

1 EPSF Missing
1 TIFF Missing

O

Print Cancel Print

Modified Picture If the file has been modified then:

When outputting in PostScript, the modified

Illustrator file will be accessed for the printout. The

message serves as a warning because the PICT

preview has not changed unless the picture has

been reimported.34

If it is necessary to view the modifications on screen,

then reimport the Illustrator file using Get Picture.
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Missing Picture If the picture is missing then:

Select the missing file from the Missing orModified

dialogue box, then select Find. Quark will locate

the file and reestablish the path so it may be

accessed for output.35

The artwork can also be imported again under Get

Picture.3(>

The dialogue box is a warning that the output will

be low resolution (provided the PICT preview has

appeared in the picture box). Quark is not able to

find the PostScript format of the artwork. Since

Quark saves only the file name of the PostScript

portion of the EPSF, itmust be able to locate and

access the original EPSF file in order to print in

PostScript. When it cannot find the original EPSF

Illustrator artwork it outputs in the PICT format

that was saved as part of the Quark document.37

Files becomeMissing files because specific conditions

must be observed to enable Quark to locate and access

EPSF files:

If the Quark document is moved to another system,

the EPSF file must be moved to that system also.38

The name of the EPSF file must remain the same

as the name used when importing the artwork.

Quark will search for the original Get Picture

name and will not recognize a new
name.39

The sequence of the folders that Quark needs to

access to locate the EPSF file is the called the
"path."

The path names and their sequence must

remain the same as in the original Get Picture.40

Quark will search in the Quark document folder if

the original path has changed. If an EPSF file

needs to be moved, relocate the file in the Quark

document folder so Quark can find it.41
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Font Substitution

within the

Artwork

If the following dialogue box appears when attempting
to print then:

A
Note: Some EPS pictures in this document contain

fonts not auailable in your System, including:

Bodoni-Bold

Print flnyiuay [ Cancel Print

An imported Illustrator file contains screen fonts

that are not available on this system. Quark

assumes that the printer font is also not available

and displays the warning. The System file may be

checked for the possible missing printer font or

select Print Anyway. If the printer font is not

available Quark will substitute Courier for the

missing
font.42

If the printer font is not resident the screen fonts

and printer fonts must be installed into the

system.

Considerations: Before and After Importation

Editing Editing of the artwork must be done in Adobe Illustrator.

Quark cannot change individual elements of the artwork

or add elements to the artwork. The only changes Quark

is capable of are changes that affect the picture in its

entirety such as scaling and duplicating. These are found

in the Item menu underModify. None ofQuark's Style

menu options can be used to modify Illustrator's EPSF

artwork.43

Scaling Scaling is dependent upon the PostScript format which is

accessed back to the original EPSF Illustrator file. Since

PostScript describes the artworkmathematically, the

quality of the output will be the same whether from

scaling in Illustrator or
Quark.44

The benefit of scaling in Quark is that you do not need to

quit Quark, then open Illustrator to scale. The results of

the scaling are on the screen for immediate viewing.

Quark's limitation is that scaling encompasses the entire

artwork. However, it can scale a picture horizontally and
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vertically independently so that proportional or
distorted

scaling can be done.

The advantage of scaling in Illustrator is that
individual

elements of the artwork can be changed in size. However,

if scaling takes place in Illustrator after importing,

modifications to the original will not appear on the screen

in Quark, but will appear in the
output.45 The artwork

must be reimported to view the changes on the screen.

Duplicating Duplicating in Quark works best if the artwork is in its

finished state. The entire picture box and its artwork is

duplicated when in Quark. Multiple duplication is

possible with the Step and Repeat function. This function

controls quantity and placement of the duplication in

equal increments horizontally and/or vertically.

In Illustratormore duplicating options exist but should

be handled before importing to eliminate jumping back

and forth between applications. The options are

duplicating individual elements rather than the whole

and duplicating while moving or transforming (rotating,

scaling, shearing, reflecting) the
elements.46

Duplicating is dependent upon the PostScript format

which is accessed back to the original EPSF Illustrator

file. Since the artwork is described mathematically by

PostScript, the quality of the duplications will be the

same from both programs.47

Saving in Quark When the document is saved after the artwork is

imported, the PICT portion of the EPSF Illustrator file is

saved with the Quark document. The PostScript portion

of the EPSF file remains in its original location, not with

the Quark document. However, saved with the document
is the EPSF file name and the path names needed to

access that EPSF file for printing.

The name of the Quark document may be changed at any

time, however the EPSF file name and the path must

remain the same as when the file was imported so that

Quark can locate it for printing.
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Importing Scanned Images from MC View Plus:

Line Art

Save Format for Integration

Considerations Importing scanned graphics is not a simple choice of a

correct format versus an incorrect format. Often more

than one save format is available for scanned fine art. The

format selected depends upon several factors. They are:

Modifications:

Are MC "Viewmodification options necessary?

Are Quarkmodification options necessary?

Screen viewing:

Is a good screen representation necessary?

Output Resolution:

Low resolution Laser printer (under 1000 dpi)

High resolution Typesetter quality

(over 1000 dpi)

The proper save sequence in MC View Plus for line art

involves choices from three separate options. The three

options and the selected choices are:

Scan selection option: Line art Output

End application option: QuarkXpress

Save format option:

TIFF Uncompressed ifQuark's Style menu

options (shade, color, and screening) are required

or if output is laser printer resolution.

EPSF ifQuark's Style menu options are not

required, and output is high resolution.

How to Save in MC View Plus

Scan Selection Line art Output is selected before the initial scan in

MC View Plus under the Scan menu.48 A V will be placed

next to the selected output. It is important that the file

be scanned as fine art since Quark treats TIFF line art

differently than other TIFF
files.49
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?Line art Output

Halftone Output

Contone Output

- Scan Menu

-Select Line art Output

Note: Pixel editing is often necessary
for fine work.

End Application After the scan select Save as under the File menu. This

displays End application options from which the target^
program, XPress (Quark), is selected from the

submenu.50

Select XPress

(Others and MC
View"

will work also. They

display the same

format options for

Line art Output)

|Q Scnnnerj

D McUleul.1n3

? McllieaiPMjf I.la3f

-. MclUeu'Plinlll.G

tltled-1

Other*

MacDraiv

PageMaker 2.0

PageMaker 3.0

s HD

]
11246 K free

Save es :

End application

Format

Info-

Ptcture|

i use this to retain the most ii

RagTime 2.0

RogTime 3.0

HPrest 1.1

tvWPress 2.0

McLHew 2.0

MacDraiull

McUlewl.O

ReadySetEo 4.0a

ImegeStudio 1.5

Illustrator 1.0,1.1

Digital Darkroom

Freehand 1.0

FreeHand 2.0

DC File info

Save Formats

Give the file a

descriptive name to

help identify
it-

Select Tiff

Uncompressed
-

or EPSF

TIFF

Uncompressed

By selecting Quark as the end application, only the

formats that Quark will accept will be displayed in the

Format submenu.51 IfOthers is selected the submenu

will display all ofMC View Plus's saving formats.

|gj Stanner| 3 Pierre's HO

-. Hcl>ieu>Plu*I.I

DMcUieu>Plus1.1D3f

-. McL>leu>P!u*III.D

E ie< t

Onup 1 2994 K free

use this to retain the most informal] non-compressed

Paint

EPSF

Tiff LZU)

Select TIFF Uncompressed if the output device is a low

resolution laser printer or Quark's Style menu options

are required (shade, color, and screening).
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EPSF Format Select EPSF if the output is a high resolution device and

Quark's Style manual options are not necessary. There is

no noticable difference between TiffUncompressed and

EPSF when printing from a laser printer. Since EPSF is

memory intensive, select this format only if the output is

high resolution. Once a file is saved in the EPSF format

no modifications may be made to
it.52 Therefore changes

in MC View are restricted to before the save and Quark

modification options (except for scaling) are ehminated.

Note: If the format is selected before the end application,

and it is not appropriate to the end application, then the

format will jump to another selection. By selecting the

end application before selecting the format the problem of

the format jumping around will be eliminated. Unnoticed

format changes may adversely affect the Quark import.

How To Import Line Art into QuarkXpress

Select the editing tool from the tool palette and click.

The selected tool will become a negative image.53

w

Create a new picture box or activate a current picture

box with a single click of the mouse.54

El -*? i M

Select Get Picture under the File Menu.

Get Picture can only be selected if a picture box

and the editing tool are
activated.55

r ifonH^

New... XN

Open... XO

Close

Saue XS

Save as...

Reuert to Saued

1 Get Picture

Saue TeHt...

Get Document...

Page Setup...

Print... XP

Transfer... XT

File Menu

Select Get Picture
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The Get Picture dialog box will appear.

Ifyou are in a file, it fists the files and folders
that

can be imported into Quark from the location

(hard disk or floppy disk) where you
opened this

file. If you are in a folder at either location, it
fists

the files in that
folder.56

A double click on a folder name will open that

folder to show you its folders or file names. Folders

can be inside folders so double click until the

desired file is found.

To change location, one click on the
"drive"

button

transfers you between the disk and hard drive.

Dialogue Pox name-

Folder on hard drive-

File inside folder-

(douPle click to

import)

Folder inside
folder-

(douPle click to

display files)

Location'

Save
format*

-? Get Picture

> Hard Disk

( Eject ]

Driue )

Open

tt [ Cancel

UK

Select the desired file for artwork importation.

The file's save format is displayed in the dialogue

box for easy verification.

A double click on a file name will import the

art from that file into the activated picture box.

A single click on a file name, then a single click on

the
"open"

button will also import the file.

The picture box from the Quark document should now

display the imported art in the picture box. The imported

picture replaces any picture that was previously

displayed in the box.
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Hints: What Has Happened

The Scanning The scanner digitizes the image into a series of pixels by
Process converting light energy to electrical signals. A light is

passed over the image and the reflection of the light from

the image is passed through a photoreceptor. The

photoreceptor converts the light into an electric signal.

The intensity of the electric (analog) signal determines

the level of grayness of the pixel (digital information)

created. Once the image information is in digital form it

can be converted into a number of save formats.57

Line art Output By selecting Line art Output, MC View takes a level of

gray and converts all darker readings to black and all

lighter readings to white. The result is each pixel is

either black or white.58 The gray level can be set auto

matically ormanually (threshold option) formore control.
5^

The TIFF Format TIFF formats are scanner formats. These formats
"tag"

the image data, rather than leaving it in rasterized (bit

mapped) form, thus the name Tagged Image File Format

(TIFF). There are several types ofTIFF formats. The

formats differ by the amount of data compression that

takes place when saving. Data may be compressed for

storage and transmission, but is then uncompressed for

display and output. Line art works well with data
compresson.60

If a TIFF format is selected for importation into Quark it

must be scanned as line art.61 Because line art does not

usually require a great deal ofmemory, TIFF Uncompress

ed has been selected as the format of choice. However,

Line art in compressed TIFF formats import with no

noticable difference in output. The TIFF formats offered

by MC View for importing into Quark are listed below in

ascending order ofmemory requirements:

TIFF CCITTStandard format with high data

compression

TIFF Packbits Standard format with single data

compression

TIFF Uncompressed Standard format without

data compression62

Importing Line Art from MC View Plus 31



The EPSF Import EPSF is the most memory intensive format. Information

is stored as mathematical equations instead of in pixel

form, then converted into pixel form at the printer. This

allows for greater precision and is considered an object

orientated format. However files cannot be altered once

they are saved in the EPSF format.63

EPSF actually creates two formats. Both formats are

contained in one file, displayed by one icon on the desktop.

One format is seen on the screen and the other is seen

as the printout when using higher resolution devices.

The first format is a PICT format, which is the
"preview"

picture seen in the picture box on the screen. This PICT

format file is used by Quark for placement, scaling, and

cropping. It is not an accurate representation of the

output. It is usually heavier with much detail filling in.

It is also the information low resolution non-PostScript

printers (such as ImageWriters) use to print. The PICT

format has smaller memory requirements and is saved

with the Quark document after it is imported.64

The second portion of the file is the PostScript format.

This is the more accurate output printed by PostScript

printers. The PostScript information is not saved with

the Quark document, but is accessed from the original

MC View file when the Quark document is printed.65

Other Formats Quark is also capable of importing Picture (PICT) and
Paint formats. A disadvantage is the Quark Style menu

is not available for these formats (and EPSF), eliminating
several useful options from Quark.66Another disadvantage

is the Paint format cannot be scaled, has size limitations,
and becomes truncated.67

Hints: What To Look For

Get Picture IfGet Text displays under the File menu instead of

Display Missing Get Picture then:

A text box is selected. Deselect the text box and

activate a picture box.68

If Get Picture is shaded instead of solid then:

The wrong tool is selected. Activate the edit tool.69
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Desired Files If the desired MC View file does not display in the Get

Missing from Get Picture dialogue box then:

Picture Display The file may reside in a different folder or it may

not be resident on the hard disk or floppy disk.

Use the Find File function found under the Apple

menu to locate it. If the file is not found then it

must be installed on the hard disk or diskette.

The file may be saved in the wrong format. The

Get Picture dialogue box will only display files that

are in an accepted format for importation (accepted

but not necessarily suitable format). Find File will

locate the file, but not display the save format.

Close the Quark file and quit the application. Go

to the location (using Find File) and look for the

TIFF or EPSF icon with the appropriate file name

in the window on the desktop. The TIFF icon will

not indicate whether it is an uncompressed or a

compressed version.

fiFF^i
MC View TIFF icon MC View EPSF icon

If the format is incorrect, a double click on the icon

will open the file so that the save format can be

changed (the application must be resident). However

the
"new"

save can only convert information

available from the
"old"

save and EPSF cannot be

converted at all. It may be necessary to rescan the

image to regain essential image information that

the
"old"

save did not save. Refer to pages 3637

for specific examples of resaving to other formats.

Blank Picture If the X inside the picture box disappears but the

Box on Screen picture box is blank then:

The picture has been imported but its visible

portions are not centered in the picture box. Use

3-shiftM to automatically center the picture

within the picture box.70

The edit tool may also be selected. The hand

portion of the tool will be activated and the picture

can be moved by
"sliding"

it with the hand.71
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Imported Files If the following dialogue box appears when attempting
Modified or to print then:

Missing

A
Some disk files for pictures in this document haue

been modified or are missing.

( List Pictures ) I Print Rnyiuay J ( Cancel Print

Go to List Pictures to determine if the problem is

missing or modified pictures. Another dialogue box

will appear listing the file name of the artwork,
page location, format of the file, and the missing or

modified
status.72

Missing or Modified TIFF/RIFF/EPS Pictures

Name Page Type Status

EPS Logo

Paint Brush

Sunset.TIFF

I EPSF Modified

I EPSF Missing
1 TIFF Missing

O

[ Print ] [ Cancel Print )

Modified Picture If the file has been modified then:

When outputting in PostScript, the modified
MC View file will be accessed for the printout. The

message serves as a warning because the screen

preview has not changed unless the picture has

been reimported.7^

If it is necessary to view the modifications on screen,

then reimport the MC View file using Get Picture.

If the picture is missing then:

Select the missing file from the Missing orModified

dialogue box, then select Find. Quark will locate
the file and reestablish the path so it may be

accessed for output. It does not reimport the file so

the screen preview remains the same.74

The artwork can also be imported again under Get
Picture.75
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The dialogue box is a warning that the output will

be low resolution (provided a screen preview has

appeared in the picture box). Quark is not able to

find the original file of the artwork. Since Quark

saves only the file name of the TIFF file or PostScript

portion of the EPSF file, it must be able to locate

and access the original file in order to print the

TIFF file or PostScript. When it cannot find the

original file it outputs in the screen format that

was saved as part of the Quark document.76

Files become missing because specific conditions must be

observed to enable Quark to locate the original files:

If the Quark document is moved to another system,

the original file must be moved to that system also.77

The name of the original file must remain the same

as the name used when importing the artwork.

Quark will search for the original Get Picture

name and will not recognize a new
name.78

The sequence of the folders that Quark needs to

access to locate the original file is the called the
"path."

The path names and their sequence must

remain the same as in the original Get Picture.79

Quark will search in the Quark document folder if

the original path has changed. If an original file

needs to be moved, relocate the file in the Quark

document folder so Quark can find it.80

EPSF PostScript If after importing an EPSF file the following message

Message appears in a gray shaded picture box then:

PostScript Picture

(title of file)

The PICT format is too large for screen viewing

and has not been imported. The PostScript portion

will be accessed for output if a PostScript printer is

used, but the PICT portion of the EPSF file is not

available for screen viewing or bitmap output from

low resolution printers.
81
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Font Substitution

within the

Imported EPSF

File

If the following dialogue box appears when attempting
to print then:

A
Note: Some EPS pictures in this document contain

fonts not auailable in your System, including:

Bodoni-Bold

[ Cancel Print ]

Magnified

Image

An imported EPSF file contains screen fonts

that are not available on this system. Quark

assumes that the printer font is also not available

and displays the warning. This may occur if text

is added to a scanned file in MC View.

The System file may be checked for the possible

missing printer font or select Print Anyway. If the

printer font is not available Quark will substitute

Courier for the missing
font.82

If the printer font is not resident the screen fonts

and printer fonts must be installed into the

system.

If the imported image appears cropped and greatly

magnified on the monitor and when printing then:

The Paint format was selected when saved. Only a
portion of the image was saved because of size

Limitations. If the file is resaved in a TIFF or EPSF

format without a new scan only a portion of the

original image is available for the
"new"

save,

although the original size will return. The image

must be rescanned to regain all information. Save

the new scan as EPSF or TIFF Uncompressed.
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Soft and If the imported image appears soft and diffused on the

Diffused Image monitor and has gray tones when printing then:

igplji

400 dpi

Fine cietai's are now

visible, the picture hae

Contone Output was selected as the scanning

format. The Contone file cannot be used as line art.

The imagemust be rescanned, selecting Line art

Output, then saved in the TIFF Uncompressed or

EPSF format.

Note: If the file was a Contone, TIFF Uncompressed

then the graymap control curve can be changed to

1100 and the file resaved. This eliminates mid-

tones but the output is not clean and crisp.

Screened and If the imported image appears jagged and coarse on

Diffused Image the monitor and appears screened with gray tones when

printing then:

Halftone Output was selected as the scanning

format. The Halftone file cannot be used as line

art. The image must be rescanned, selecting Line

art Output, then saved in the TIFF Uncompressed

or EPSF format.
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Considerations: Before and After Integration

Although many of the functions and tools in Quark and

MC View are specialized and unique to the particular

program, several may appear to overlap or handle

similiarly. The user is faced with the decision in which

program to apply the overlapping functions. The reasons

to work in one program over another vary. They depend

upon whether both programs are available to use, whether

the programs can address the save format of the file, the

results desired, and differences in how the similiar

functions work. Overlapping functions and tools from

Quark and MC View are discussed in the following pages.

Scaling Scaling may be done in MC View when scanning or in

Quark, regardless of the save format. The quality of

scalingwill be the same from both programs.

In MC View, time is saved by scaling during the scan, but

the final image size must be known. If the final image

size is not known then scaling in Quark is the only

option. However the results of scaling in Quark are

displayed on the screen and allow for quick changes

when playing with layout sizes.

Ifmemory requirements are the primary consideration,

especially for the memory intensive EPSF format, the

choice of programs would depend upon the size of the

final image. When scaling larger in MC View more

memory is used and the better choice may be to scale in

Quark. The opposite would be true of scaling smaller.

Quark also allows disproportionate scaling, which is not

offered in MC View.

Duplicating In Quark, the entire picture box and its contents are

duplicated using the Items menu Duplicate function.

Multiple duplication is possiblewith the Step and Repeat
function. This function controls quantity and placement

of the duplication in equal increments horizontally
and/or vertically. Once duplicated, the boxes are separate
entities and can be arranged independently.
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Duplicating entire images in MC View is not always

feasible. It is actually a cutting and pasting operation

and should be used when individual elements need to be

duplicated. The duplicated elements and their placement

become part of the image file. If the entire image must be

duplicated in MC View there must be enough white space

to hold the copied image, since what is underneath will

be replaced by the image on top.

The quality of the duplications will be the same from

both programs.

Text and Rules In general the same advantages and limitations apply to

text and rule tools. Quark is the more versatile program

to work in when using these tools. MC View's range of

options for these tools are limited.

In MC View text and rules become part of the image file

and cannot be separated from the image. When the text

and rules are active theymay be moved and placed within

the image file. However, once they are no longer active,

they become part of the image and the information under

neath is lost. So cutting and pasting to move text or rules

to another location will leave a blank hole at the original

location.

In Quark, text and rules are separate entities and not

part of the image. Text is contained within text boxes,

and text boxes and rules may be moved for placement at

any time without disturbing the image underneath.

Although the text boxes and rules are not part of the

image they may be locked in place so that the picture box

and its contents can be treated as a whole unit.
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Importing Scanned images from MC View Plus:

Continuous Tone

images

Save Format for Integration

Considerations Importing scanned graphics is not a simple choice of a
correct format versus an incorrect format. Often more

than one save format option is available. The available

save format options depend on the scanning output

selection. Several factors affect the scan output selection

and the resulting save format selection. They are:

Modifications:

Are MC Viewmodification options necessary?

Are Quark modification options necessary?

Screen viewing:

Is a good screen representation necessary?

Output Resolution:

Low resolution Laser printer (under 1000 dpi)

High resolution Typesetter quality

(over 1000 dpi)

Save Format

Options

The proper save sequence inMC View Plus involves

choices from three separate options. The three options

and the available choices are:

Scan selection option:

Halftone Output modification of the image

is not possible after scanning. All scaling, tone

curve corrections, and halftone screen selection

must be chosen before the scan. This provides

optimum quality for low resolution laser output

but limits control of the image in both MC View

and Quark. A halftone screen is automatically

generated during the
scan.83

Contone Output modification of the image

is possible after scanning in both MC View and

Quark. This is suitable for any PostScript output

device. The user has control ofhalftone screening
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and the resulting gray levels in the program

from which the file is being sent to the printer

(MC View or Quark). A PostScript halftone

screen is generated during
printing.8^

End application option: QuarkXpress

Save format option:

IfHalftone Output, then EPSF for:

Output on low resolution laser printers and

if image modifications are not necessary

before or after scanning and monitor

viewing is not necessary.
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IfContoneOutput, then TIFFUncompressed if:

Image modifications are necessary in either

MC View or Quark, and monitor viewing is

important. Output can be laser printer or

typesetting resolution.
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IfContone Output, thenEPSF if:

Image modifications can be taken care of in

MC View before saving as EPSF, and no

modifications except scaling are required in

Quark, and monitor viewing is not important,

and output is a higher resolution device

requiring fine halftone
screening.

Note: Refer to Hints:What Has Happened for a

more detailed discussion of these scanning and

saving format combinations (pp. 47-51).
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How to Save in MC View Plus

Scan Selections Halftone Output is selected before the initial scan under

Halftone Output the Scan menu.85 A V will be placed next to the selected

output. Select for halftone screening during scanning.
Scan resolution shouldmatch output resolution.86

Contone Output

Scan Menu

Line art Output

?Halftone Output'

Contone Output

Select Halftone Output

Contone Output is selected before the initial scan in

MC View under the Scan menu.87 A V will be placed next

to the selected output. Select for halftone screening

during printing.

Line art Output

Halftone Output

?Contone Output
-*-

Scan Menu

Select Contone Output

End Application

Select XPress-

After the scan select Save As under the File menu. This

displays End application options from which the target

program,XPress (Quark), is selected from the submenu.88

|Q Scanner]

QMcUleuM.1e3

-. McMleu>P!u* I . I

? McUieu/Plus1.1b3f

-. Mcleu>PIU*IH.O

id-l

r2.0 J

r3.0 "1

n J

Saue as ;

End application

Format

Info

McUieiu 2.0

Picture I

use this to retain the most li

Othert

MncDroiu

PageMaker 2.0

PageMaker 3.0

BBS
RagTJme 2.0

RagTime 3.0

XPress 1.1

?HPrets 2.0

McUleui 2.0

MacDraivll

MclMeu/1.0

ReadySetEo 4.0a

ImogeStudio 1.5

Illustrator 1.0,1.1

Digital Darkroom 1 .

FreeHand 1.0

FreeHand 2.0

sHD

II 246 K free

] [ File Info )

Save Formats By selecting Quark as the end application, only the

formats Quark will accept for the selected scan output

will be displayed in the Format submenu.89 IfOthers or

MC View is selected the submenu will display all of the

saving formats applicable for that type of scan.

Select EPSF ifHalftone Output was selected. Select
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TIFF Uncompressed or EPSF if Contone Output was

selected, depending on which format fits your needs.

Give the file a

descriptive name to

help identify
it"

Select Tiff

Uncompressed,
or

EPSF-

IQ Scanner] 3Pierre's HD

-. McUleu>Plutl.l

CD McUlewPlus1.lb3J
'. McuiaiWIutlll.D

Saue as :

End application

Format

Info

[ Eject I

| Onue ) 1 2994 K free

f Saue |

| Cancel ] [ File Info ]

McUleui2.ol

vnff uncompressed

Picture

non-compressed

Paint

EPSF

Tiff L2IU

Note: If the format is selected before the end application,

and it is not appropriate to the end application, then the

format will jump to another selection. By selecting the

end application before selecting the format the problem of

the format jumping around will be eliminated. Unnoticed

format changes may adversely affect the Quark import.

How To Import Continous Tone Images into QuarkXpress

Select the editing tool from the tool palette and click.

The selected tool will become a negative image.90

W

Create a new picture box or activate a current picture

boxwith a single click of the mouse.91

M

46

Select Get Picture under the File Menu.

Get Picture can only be selected if a picture box

and the editing tool are
activated.92

Neiv-

opn_

XN

no

MS

Clou

Ssue

Saue a*

to Saved

File Menu

Get Picture

Saue Tern

SelectGet Picture
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The Get Picture dialogue box will appear.

Ifyou are in a file, it lists the files and folders that

can be imported into Quark from the location (hard

disk or floppy disk) where you opened this file. If
you are in a folder at either location, it lists the

files in that folder.93

A double click on a folder name will open the folder

to show display its folders or files. Folders can be

inside folders so double click until the desired file

is found.

Dialogue box name

Folder on hard drive

File inside folder

(double click to

import)

Folder inside folder

(double click to

display files)

Locatior

Save
format"

Q File Plcts]

To change location, one click on the
"drive"

button

transfers you between the diskette and hard disk.

? Get Picture

Q Clip Art

D Halftones

O Line fir

Ea

'Hard Disk

[ Oriue ~~)

Open 1

Type: Paint

[ Cancel ]

Size: 11 K

Select the desired file for artwork importation.

Its save format is displayed in the dialogue box.

A double click on a file name will import the art

from that file into the activated picture box.

A single click on a file name, then a single click on

the
"open"

button will also import the file.

The picture box from the Quark document should now

be displayed with the imported art in the picture box.

Hints: What Has Happened

The Scanning
Process

The scanner digitizes the image into a series ofpixels by

converting fight energy to electric signals. A fight is

passed over the image and the reflection of the light from

the image is passed through a photoreceptor. The

photoreceptor converts the light into an electric signal.
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The intensity of the electric (analog) signal determines

the level of grayness of the pixel (digital information)

created.94 Each pixel is comprised of a matrix of dots that

are turned on or offby the laser scanning device. The

perceived grayness of the pixel formed by the dots depends

upon the number of dots turned on or off. For example, a

matrix of4 x 4 yields 16 dots, thus 17 levels of perceived

grayness are
possible.95

???? ???? ???? ???? ???? pyys
DDDD DDBD ??? DBBD DBBD DBBD
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OBBD DBBD OBBD DBBD OBBD BBBD

BOOD BODD BDDB BDDB BDDB BDDB

BDDB BDOB BDDB BBDB BBBB
BBBB BBBB BBBB BIIBB BBBB

BBBB BBBB BBBB BBBB BBBB

BDDB BBDB BBBB BBBB BBBB

The output device has a set number of dots it is capable

of printing, referred to as resolution. Since the resolution

of the device remains constant, if the screen ruling

becomes finer, less levels of gray are possible. Conversely,

more levels of gray are possible with coarser screen

rulings. The number of dots is constant but divided

differently. Once the image is in digital form it can be

converted into a number of save formats.9^

Halftone Output The Halftone Output option is intended for low resolution

laser printers. When Halftone Output is selected a

halftone screen suitable for the scan resolution indicated

is generated during the scan. The creation of a halftone

screen from gray scale information as it is being scanned

is an involvedmathematical process. It ultimately

eliminates successful modification of the image after the

scan, including
scaling.97

Halftone Output

with EPSF

This combination gives the closest representation of the

original when outputting on a laser printer. Advantages

and disadvantages are:

Memory and time requirements usually associated

with EPSF files are not as cumbersome when using

Halftone output. Screened grayscale information

requires less memory than pure grayscale informa

tion. The quality of the output is worth the memory

this format uses.

48 The Integration Training Module



Scalingmust be done during scanning
98

Contone Output

The scanning process tends to exaggerate high

contrast originals and darken shadows.99 Since no

loss in tone occurs when importing this type of scan,
tone compensation may be needed in MC View

before scanning to compensate for darkened shadows.

The screen display is illegible, eliininating soft proof

ing. Placement is possible only by aligning edges of

the imported file with edges of the picture box.

Proofing can be time intensive. To make changes

and proof those changes, the imagemust be rescanned

with the changes, saved, reimported, then printed.

When Contone Output is selected a PostScript screen is

generated duringprinting. Since the halftone screen is

generated later, the scanned image is pure gray scale

information. The altered and saved file is translated into

a screened image only when the file is sent to the printer.

Therefore screening decisions may be made at the point

of printing. The image may be modified in MC View and

Quark after the scan.100

Contone Output This combination is the best overall selection when the

with TIFF image files need extensive modification. The advantages

Uncompressed and disadvantages are:

All ofMC View and Quark's modification options are

available after scanning and
saving.101' 102

The screen display is very good, allowing convenient

soft proofing when modifying and placing the image.

A signifigant overall loss of tone occurs when a

Contone file is imported into Quark. Tone compensa

tion can be made in MC View or Quark.

The halftone screen is less noticable than with

EPSF output, when outputting on a laser printer.

Contone files require more memory than halftone

files because pure gray scale information is saved.

However Contone, TIFF Uncompressed files
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Contone Output

with EPSF

require approximately one-half the memory
require

ments ofContone, EPSF files.

This combination is the best selection if the output device

is high resolution and fine screening rulings are desired.

Advantages and disadvantages are:

The filemay bemodified after the original scan,
before

the EPSF save. Files cannot be altered (except scaling)

in MC View or Quark once saved as EPSF.103-
104

An overall loss of tone occurs when a Contone file is

imported. Compensate before saving as EPSF.

The screen display is illegible, eliminating soft proof

ing. Placement is possible only by aligning edges of

the imported file with edges of the picture box.

Hard proofing can be time intensive. Tomake changes

and proof those changes the imagemust be rescanned

with the changes, saved, reimported, then printed.

The halftone screen is sharper in an EPSF file,

making it highly visible in output from a low resolu

tion printer. The EPSF format should be reserved

for high resolution output where finer halftone

screening is possible without sacrificing gray levels.

Contone files require much more memory and print

ing time than halftone files because pure gray scale

information is saved. The EPSF format is also

memory intensive. A Contone scan with the EPSF

save format is the most memory intensive

combination.

The TIFF Format TIFF formats are scanner formats. These formats
"tag"

the image data, rather than leaving it in rasterized (bit

mapped) form, thus the name Tagged Image File Format

(TIFF). There are several types ofTIFF formats. The

formats differ by the amount of data compression that
takes place when saving. Data may be compressed for

storage and transmission, but is then uncompressed for

display and output. Images with gray scale information
such as continuous tone and halftone images do not work

well with data compresson. Do not compress TIFF files.105
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TIFF files display a low resolution representation of the

image on screen. This screen format has smaller memory

requirements and is saved with the Quark document

after it is imported. The high resolution information is

retained in the original file. This high resolution informa

tion is accessed from the original MC View file when the

Quark document is printed.106

The EPSF Format EPSF is the most memory intensive format. Information

is stored as mathematical equations instead of in pixel

form. This allows for greater precision and is considered

an object-orientated format.107 EPSF actually creates

two formats. Both formats are contained in one file,
displayed by one icon when viewed on the desktop. One

format is seen on the screen and the other is seen as the

printout when using higher resolution devices.

The first format is a PICT format, which is the
"preview"

picture seen in the picture box on the screen. This PICT

format file is used by Quark for placement, scaling, and

cropping. It is not a good representation of the output

because it cannot display gray tones. Therefore the display
is often predominantely black with great loss of detail. It

is also the information which low resolution non-

PostScript printers (such as ImageWriters) use to print.

The PICT format has smaller memory requirements and

is saved with the Quark document after it is imported.108

The second portion of the file is the PostScript format.

This is the more accurate output printed by PostScript

printers. The PostScript information is not saved with

the Quark document, but is accessed from the original

Illustrator file when the Quark document is printed.109

Hints: What To Look For

Get Picture IfGet Text displays under the File menu instead of

Display Missing Get Picture then:

A text box is selected. Deselect the text box and

activate a picture
box.110

IfGet Picture is shaded instead of solid then:

The wrong tool is selected. Activate the edit
tool.111
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Desired Files If the desiredMC View file does not display in the Get

Missing from Get Picture dialog box then:

Picture Display The file may reside in a different folder or it may

not be resident on the hard disk or floppy disk.

Use the Find File function found under the Apple

menu to locate it. If the file is not found then it

must be installed on the hard disk or diskette.

The file may be saved in the wrong format. The

Get Picture dialogue boxwill only display files

that are in an accepted format for importation.

(accepted but not necessarily suitable format) Find

File will locate, but not display the save format.

Close the Quark file and quit the application. Go

to the location (using Find File) and look for the

TIFF or EPSF icon with the appropriate file name

in the window. The TIFF icon will not indicate

whether it is uncompressed or a compressed version.

MC View TIFF icon [
"

MC View EPSF icon

If the format is incorrect, a double click on the icon

will open the file so that the save format can be

changed (the application must be resident).

However the
"new"

save can only convert informa

tion available from the
"old"

save. It may be

necessary to rescan the image to regain essential

image information that the
"old"

save did not save.

Also, EPSF formats cannot be resaved as other

formats. Refer to pages 5562 for more specific

examples of resaving to other formats.

Blank Picture If the X inside the picture box disappears but the

Box on Screen picture box is blank then:

The picture has been imported but its visible

portions are not centered in the picture box. Use

3shiftM to automatically center the picture

within the picture box.112

The edit tool may also be selected. The hand portion

of the tool will be activated and the picture can be

moved by
"sliding"

it with the band.113
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Imported Files

Modified or

Missing

If the following dialogue box appears when attempting
to print then:

A
Some disk files for pictures in this document haue

been modified or are missing.

[ List Pictures ] l( Print Rnymay]] [ Cancel Print J

Go to List Pictures to determine if the problem is

missing or modified pictures. Another dialogue box

will appear listing the file name of the artwork,
page location, format of the file, and the missing or

modified
status.114

Missing or Modified TIFF/RIFF/EPS Pictures

Name Page Type Status

EPS Logo

Paint Brush

Sunset.TIFF

I EPSF Modified

I EPSF Missing
I TIFF Missing

O

Find J C Print Cancel Print )

Modified Picture If the picture has been modified then:

When outputting in PostScript, the modified

MC View file will be accessed for the printout. The

message serves as a warning because the screen

preview has not changed unless the picture has

been reimported.115

If it is necessary to view the modifications on screen,

then reimport the MC View file using Get Picture.

Missing Picture If the picture is missing then:

Select the missing file from theMissing orModified

dialogue box, then select Find. Quark will locate

the file and reestablish the path so it may be

accessed for output. It does not reimport the file so

the screen preview remains the same.116

The artwork can also be imported again under Get

Picture.117
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The dialogue box is a warning that the output will

be low resolution (provided a screen preview has

appeared in the picture box). Quark is not able to

find the original file of the artwork. Since Quark

saves only the file name of the
TIFF file or

PostScript portion of the EPSF file, it must be able

to locate and access the original file in order to

print the TIFF file or PostScript.When it cannot

find the original file it outputs in the screen format

that was saved as part of the Quark
document.118

Files become missing because specific conditions
must be

observed to enable Quark to locate the original files:

If the Quark document is moved to another system,

the original file must be moved to that
system.119

The name of the original filemust remain the same

as the name used when importing the artwork.

Quarkwill search for the original Get Picture

name and will not recognize a new
name.120

The sequence of the folders that Quark needs to

access to locate the original file is the called the
"path."

The path names and their sequence must

remain the same as in the original Get
Picture.121

Quark will search in the Quark document folder if

the original path has changed. If an original file

needs to be moved, relocate the file in the Quark

document folder so Quark can find it.122

EPSF PostScript If after importing a EPSF file the followingmessage

Message appears in a gray shaded picture box then:

PostScript Picture

(title of file)

The PICT format is too large for screen viewing

and has not been imported. The PostScript will be

accessed for output if a PostScript printer is used,

but the PICT portion of the EPSF file is not

available for screen viewing or bitmap output from

low resolution printers.123
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Font Substition

Within the

Imported EPSF

File

If the following dialogue box appears when attempting
to print then:

A
Note: Some EPS pictures In this document contain

fonts not available in your System, including:

Bodoni-Bold

Print flnyujayj [ Cancel Print )

An imported EPSF file contains screen fonts

that are not available on this system. Quark

assumes that the printer font is also not available

and displays the warning. This could occur if type

is added to a scanned file in MC View.

The System file may be checked for the possible

missing printer font or select Print Anyway. If the

printer font is not available Quark will substitute

Courier for the missing
font.124

If the printer font is not resident the screen fonts

and printer fonts must be installed into the

system.

Illegible Screen If an imported image appears nearly all black and

Display, illegible on the monitor but the output is good then:

Good Output It is saved in the EPSF format. The screen preview

is very poor, but is normal. This format cannot be

changed. Rescan if another format is desired.

Magnified If the imported image appears very dark with large

Display and pixels on the monitor and when printing then:
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Missing Midtones

The Paint format was selected when saving a Half

tone scan. Only a portion of the image was saved

because the image has been greatlymagnified.

Rescan the image to regain all image information.

Save in the EPSF format if it is a Halftone scan, or

in TIFF Uncompressed or EPSF formats if it is a

Contone scan.

If an imported image is black and white with no

midtones then:

Line art Outputwas selected as the spanning format

or Contone Output was selected but the graymap

control was set to eliminate midtones. The image

must be rescanned as Halftone or Contone Output

to regain gray scale information.
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Jaggy Display If the imported image is jaggy but legible on the
and Output monitor and jaggy but much lighter in tone when

printing then:

Halftone Output and TIFF Uncompressedwere

selected as the scanning and saving formats. Open

the file and resave as the EPSF format under Save

As. The tone loss occurs when the file is imported

into Quark in the TIFF format (Halftone Output),
but will not occur when importing the EPSF format

(Halftone Output). Since the original TIFF file is

not affected, tone compensation is not necessary.

Importing Continous Tone Images from MC View 57



Loss of Overall

Tone

(Contone scan,

TIFF format)

If the output is too light after importing and if the file

is a Contone, TIFF Uncompressed then:

The loss of tone occurs with the import ofContone

files in both the TIFF and EPSF formats. The

original files do not reflect this loss of tone. Adjust

the tone curve in Quark if permanent changes to

the image file are not necessary. The tone curve

may be altered in MC View if the file is to be used

in the future and permanent changes to the image

are desired.
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Loss Of Overall If the output is too fight after importing and if the file
Tone is a Contone, EPSF then:

(Contone scan,

EPSF format)

The loss of tone occurs with the import ofContone

files in both the TIFF and EPSF formats. The

original files do not reflect this loss of tone. The

tone can only be altered before the EPSF save.

Rescan the image, compensate for tone, then save

in the EPSF format. The imagemust be hard

proofed because of poor monitor display. This can

be a lengthy process. Not only are many steps

required, but EPSF files are the most memory

intensive and take more time than other files to

save, import, and print.
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MC View Won't If the followingmessage appears when attempting to

Address File open a MC View file from the desktop then:

The file is in the EPSF format, whichMC View cannot

open. The EPSF file may be viewed through a picture box

after importing into Quark. Since no modifications can be
made to this file, except scaling in Quark, itmust be re

scanned if it is not acceptable.

Ifopening from MC View the files will not be displayed

for selection.

Halftone Output If the printout from a Halftone Output scan is coarsely
is Coarse screened then:

The scan resolution was less than the printer's

resolution. The screen that was automatically
generated during the scan was intended for a
lower resolution printer. Rescan the image,
matching the scan resolution to the printer's

resolution. Compare the above image, scanned at
200 dpi, to the original sized image on the opposite
page, scanned at 400 dpi.
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Scaling Halftone

Outputs

If an imported Halftone image has been scaled then:

If the image is scaled larger, the screen is scaled

larger also, making it appear coarser and more

visible. This makes the image appear lighter in

overall tone.

Original size

Scaled at 200%

If the image is scaled smaller, the screen is scaled

smaller also, making it so fine that detail fills in.

The image appears darker in overall tone.

Halftone Output scans should be scaled at the

time of the scan.125 Rescan the image after

determining the proper scaling.
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Considerations: Before and After Integration

Although many of the functions and tools in Quark and

MC View are specialized and unique to the particular

program, several may appear to overlap or handle

simiharry. The user is faced with the decision in which

program to apply the overlapping functions. The reasons

to work in one program over another vary. They depend

upon whether both programs are available for use, whether

the programs can address the save format of the file, the

results desired, and differences in how the simi liar

functions work. Overlapping functions and tools from

Quark and MC "View are discussed in the following pages.

Halftone When looking atMC View and Quark there appears to be

Screening a number of locations where screening selections may be

made. Screening options are offered in the following
locations:

MC View Plus:

Scanning dialogue box (Halftone Output only):
LaserWriter dot

Display dot

P400PS dot

Line 45

Filemenu (all scanning outputs)

Page Setup: Proof printer

Page Setup: EPSF file

QuarkXpress:

Style menu (not available for EPSF formats):

Normal

60-Line Line Screen/0

30-Line Line Screen/450

20-Line Dot Screen/450

Other Screen user defined screens

File menu:

Page set up user denned lpi

The user wonders where the best place is to make the

screening selection, which selection takes precedence,
and how it will affect output. In actuality, the user has

very few choices to make for this function. The selections

actually available depend upon the scanning output

selection and the save format. The key is to sorting out
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which selections take precedence, even when various

menus are active and appear to make options available.

Screening for The Halftone Output scanning mode generates a halftone

Halftone Output screen during the scan. Therefore a screen must be select
ed before the scan. When the scanning dialogue box

appears the user must select the type ofhalftone screen

to be used: LaserWriter dot, Display dot, P400PS dot, or

Line 45. The scan resolution should match the resolution

of the laser printer being used for output. The scanner

automatically creates a halftone screen, with gray levels

suitable for the resolution of the laser printer, while

scanning.126

All other screen options may be ignored in MC View and

Quark. This file's screening information overrides all

other screening options in MC View or Quark, when in

the recommended save format, EPSF.

Screening for

Contone Output

Proof Printing
Files in

MC View

Printing Files in

Quark:

Contone, TIFF

Uncompressed

The Contone Output scanningmode saves pure grayscale

information. A halftone screen is not generated until the

file is sent to the printer. Therefore screen selections

depend upon the application from which the file is being
printed or the save format of the imported image.127

Screen selections must be made in MC View if proof

printing from MC View. Set screen preferences by pulling
down the File menu and selecting Page Setup, Proof

Printer. All Contone files printed from the MC "View

application will display the proofprinter screen.

Screen information does not come over with imported

TIFF files, only grayscale information. Quark sends the

screening requirements to the printer, so screen selections

must be made in Quark.

When Quark imports TIFF images, the Style menu will

be active. Several preset screens are available, as well as

Other screens, which allows the user to define the screen

parameters.127 The lpi of the Normal screen option is

also user defined. It may be changed by selecting Page

Setup under the File menu. Find the Halftone screen box
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Printing Files in

Quark:

Contone, EPSF

Type of

Scanned File

and type the number of lpi desired, then click on Okay.

Only the lpi of the Normal screen will be changed.

Since EPSF files cannot be altered once saved, the screen

selection is made inMC View and that screen information

is saved with the image file. Quark cannot alter the

screen information that has been imported with the EPSF

file. The screen is defined in MC View by selecting Page

Setup under the File menu, then selecting EPSF file

from the pull down menu. The imagemust be rescanned

if the original screen selection needs to be changed.

Note: The usermay change EPSF file screen selections,

proof print, and wonder why the Proof printer selection

takes precedence when printing EPSF images from

MC View. The reason is the file may have been saved as

EPSF, but has not been closed. TIFF is a scanner format

and the TIFF information is not converted to EPSF until

the file is closed. The proofprint is a representation of

the original scanner format TIFF Uncompressed. EPSF

files cannot be reopened in MC "View once they have been

closed because MC View does not address the EPSF

format. However, once the EPSF file has been saved and

closed, the EPSF screen information has been irrevocably
saved with the file and will go with it into Quark.

The following chart will aid users in making the

screening selections in the appropriate location and at

the proper time.

Where to Select a Halftone Screen

Halftone Output

EPSF

Contone Output

TIFF

Uncompressed

EPSF

MC View Plus

Must select before scanning from

Scanning Dialogue Box

Select from Page Setup:

Proof Printer (File menu)

if printing from MC View

Select from Page Setup:

EPSF File

if printing from Quark

(the screen is saved and

imported with with the file)

QuarkXpress

Not available for EPSF

Select from Style Menu

if printing from Quark

Not available for EPSF
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Scaling Scalingmust be done inMC Viewwhen scanning. It is

Halftone Output important to know the final image size before scanning

so the proper calculations can be made for the scan.129

Contone Output Scaling may be done in MC View when scanning or in

Quark, regardless of the save format. The quality of

scalingwill be the same from both programs. In both

programs scaling smaller will result in a loss of resolution.

Scaling larger yields some distortion.130 Excessive

scaling should be avoided.

In MC View, time is saved by scaling during the scan, but

the final image size must be known. If the final image

size is not known then scaling in Quark is the only option.

However scaling in Quark allows the results to be

displayed on the screen immediately. This permits changes

to be viewed quicklywhen playingwith layout sizes.

Ifmemory requirements are the primary consideration,

especially for the memory intensive EPSF format, the

choice of programs would depend upon the size of the

final image. When scaling larger in MC "View more

memory is used and the better choice may be to scale in

Quark. The opposite would be true of scaling smaller.

Quark also allows disproportionate scaling, which is not

offered in MC View.

Duplicating In Quark, the entire picture box and its contents are

duplicated using the Items menu Duplicate function.

Multiple duplication is possible with the Step and Repeat

function. This function controls quantity and placement

of the duplication in equal increments horizontally
and/or vertically. Once duplicated, the boxes are separate

entities and can be arranged independently.

Duplicating images in MC View is not always feasible. It

is actually a cutting and pasting operation, and should be

used when individual elements need to be duplicated. The

duplicated elements and their placement become part of

the image file. If the entire image must be duplicated in

MC View theremust be enough white space to hold the

copied image, since what is underneath will be replaced.
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The quality of the duplications will be the
same from

both programs.

Text and Rules In general the same advantages and limitations apply to

text and rule tools. Quark is the more versatile program

to work in when using these tools. MC View's range of

options for these tools are limited.

In MC "View text and rules become part of the image file

and cannot be separated from the image. When the text

and rules are active theymay be moved and placed within

the image file. However, once they are no longer active,

they become part of the image and the information under

neath is lost. So cutting and pasting to move text or rules

to another location will leave a blank hole at the original

location.

In Quark, text and rules are separate entities and not

part of the image. Text is contained within text boxes,

and text boxes and rules may be moved for placement at

any time without disturbing the image underneath.

Although the text boxes and rules are not part of the

image, theymay be locked in place so that the picture

box and its contents can be treated as a whole unit.

Contrast or Tone

Compensation

Controls

Halftone Output,

EPSF

Contone

Output, TIFF

Uncompressed

When looking atMC View and Quark there appears to be

a number of locations where contrast or tonemodifications

may be made. However the availability is dependent

upon the scan output and save formats used.

Tone compensation is only available before scanning in

MC View in the scanning dialogue box. The user selects

tone curves by choosing options such as Light original,
Dark original, Brighten shadows,

etc..131 Other contrast

options are not active after scanning in MC "View or after

importing in
Quark.132

The important consideration when importing a Contone

file is that an overall loss of tone occurs with the import.

Contrast control is offered in MC View under the "View

menu Graymap control option.133 Users can compensate
for the tone loss while still in theMC View program, but

will not see the results until it is imported into Quark.
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Although the output is similiar from both functions, it is

easier to alter the tone curve in Quark. The user can

view the tone loss, which occurred with the import, on

the monitor in Quark and can view adjustments

immediately. Quark offers extensive modifications

options under the Style menu Contrast option.134

Contone Contrastmodifications must be made in MC View before

Output, EPSF the file is saved and then closed in the EPSF format,
because files cannot be altered once converted to the

EPSF format.135 Before the file is closed it is still in the

scanning format TIFF Uncompressed. The conversion

from TIFF to EPSF takes place when the file is closed.

MC View will not address the file once it is closed.

Contrast control is offered in MC View under the View

menu Graymap control
option.136 The same loss of tone

that occurs with the Contone TIFF Uncompressed import

will occur with the EPSF format. Users can compensate

for the tone loss while still in the MC View program, but

will not see the results until it is output from Quark.

Quark will not activate its Style menu (where the

contrast controls are located) to EPSF files.137 The image

must be rescanned, modified, saved and closed, imported,

and output until the desired results are achieved.
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Importing Scanned Images from MC View Plus:

Save Format for Integration

Considerations Importing scanned graphics is not a simple choice of a

correct format versus an incorrect format. Often more

than one save format option is available. The available

save format options depend on the scanning output

selection. Several factors affect the scan output selection

and the resulting save format selection. They are:

Modifications:

Are MC View modification options necessary?

Are Quarkmodification options necessary?

Screen viewing:

Is a good screen representation necessary?

Output Resolution:

Low resolution Laser printer (under 1000 dpi)

High resolution Typesetter quality

(over 1000 dpi)

Save Format The proper save sequence in MC View involves choices

Options from three options. Regardless of the choices made, the

Descreen buttonmust be on when scanning. Since the

original image is a halftone, descreeningwill prevent or

discourage moire patterns from developing when the

printer or scanner creates a halftone screen.138 This is the

difference between scanning continuous tone and halftone

originals. The three options and the available choices are:

Scan selection option:

Halftone Output manipulation of the image

is not possible after scanning. All scaling, tone

curve corrections, and halftone screen selection

must be chosen before the scan. This provides

optimum quality for low resolution laser output

but limits control of the image in both MC View

and Quark. A halftone screen is generated

during the scan.
139
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Contone Output manipulation of the image

is possible after scanning in both MC View and

Quark. This is suitable for any PostScript output

device. The user has control ofhalftone screening

and the resulting gray levels in the program

from which the file is being sent to the printer

(MC View or Quark). A PostScript halftone

screen is generated duringprinting.

End application option: QuarkXpress

Save format option:

IfHalftone Output, then EPSF for:

Output on low resolution laser printers and

if image modifications are not necessary

before or after scanning and monitor viewing

is not necessary.
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IfContoneOutput, thenTIFFUncompressed if:

Image modifications are necessary in either

MC View or Quark, and monitor viewing is

important. Output can be laser printer or

typesetting resolution.
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IfContoneOutput, thenEPSF if:

Image modifications can be taken care of in

MC View before saving as EPSF, and no

modifications except scaling are required in

Quark, and monitor viewing is not important,

and output is a higher resolution device

requiring fine halftone
screening.

Note: Refer to Hints: What Has Happened for a more

detailed discussion of scanning and saving format

combinations (pp. 77-81).
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How to Save in MC View Plus

Scan Selections Halftone Output is selected before the initial scan under

Halftone Output the Scan menu.141 A V will be placed next to the selected

output. Select for halftone screening during scanning.
Scan resolution should match output resolution.142

Contone Output

Scan Menu

Line art Output

?Halftone
Output-

Contone Output

Select Halftone Output

Contone Output is selected before the initial scan in

MC View under the Scan menu.143 A V will be placed

next to the selected output. Select for halftone screening

during printing.

Line art Output

Halftone Output

v/Contone Output
-*-

Scan Menu

Select Contone Output

End Application

Select XPress -

After the scan select Save As under the File menu. This

displays End application options from which the target

program, XPress (Quark), is selected from the submenu.144

|Q Scanner|

D McView I.1a3

'. Mct>leu>Plu*U

OMcUieu;Piusl.1b3f

Mclhen>Plutlll.O

ed-! -i
Saue as :

End application

Format

info

| Picture |

use this to retain the most ii

Others

MacOreu)

PageMaker 2.0

PageMaker 3.0

RagTime 2.0

RagTime 3.0

XPress 1.1

?HPress 2.0

McUletu 2.0

MacDrauJll

McUleu/1.0

Ready$et&o 4.0a

ImogeS tudio 1.5

Illustrator 1.0,1.1

Digital Darkroom 1 .0

FreeHand 1.0

FreeHand, ;,n

s HO

1 1 246 K free

DC File info

Save Formats By selecting Quark as the end application, only the

formats Quark will accept for the selected scan output

will be displayed in the Format submenu.145 IfOthers or

MC View is selected the submenu will display all of the

saving formats applicable for that type of scan.

Select EPSF if Halftone Output was selected. Select

Importing Halftone Images from MC View Plus 73



TIFF Uncompressed or EPSF if Contone Output was

selected, depending on which format fits your needs.

Give the file a

descriptive name to

help identify
it-

Select Tiff

Uncompressed,
or EPSF

-

[Q Scanner! 3Pierre's HO

-. Mci>ieu>Pluti.l

? McUleujPlusl.lb3J

: MclMeu'Plmlll.O 1 2994 K free

Saue as :

End application

Format

Info

I Tiff uncompressed
v-tim uncompressed

Picture

non-compressed

Paint

EPSF

Tiff LZUJ

Note: If the format is selected before the end application,

and it is not appropriate to the end application, then the

format will jump to another selection. By selecting the

end application before selecting the format the problem of

the format jumping around will be eliminated. Unnoticed

format changes may adversely affect the Quark import.

How To Import Halftone Images into QuarkXpress

Select the editing tool from the tool palette and click.

The selected tool will become a negative image.14^

w

Create a new picture box or activate a current picture

box with a single click of the mouse.147

El

74

Select Get Picture under the FileMenu.

Get Picture can only be selected if a picture box

and the editing tool are
activated.148

New..

Open...

XN

XO

xs

close

save

Save as...

Reuert to Saved

Get Picture

Saue Tern.

File Menu

Select Get Picture
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The Get Picture dialogue box will appear.

If you are in a file, it lists the files and folders that

can be imported into Quark from the location (hard

disk or floppy disk) where you opened this file. If
you are in a folder at either location, it lists the

files in that folder.149

A double click on a folder name will open the folder

to show display its folders or files. Folders can be
inside folders so double click until the desired file

is found.

Dialogue box name

Folder on hard drive

File inside folder

(double click to

import)

Folder inside
folder-

(double click to

display files)

Locatior

Save
format"

To change location, one click on the
"drive"

button

transfers you between the diskette and hard disk.

Get Picture

Q File PictT)

CD Clip Art

? Halftones

Q Line Art

O

Hard Disk

1 nn l

( Driue 1

II Pen 1

[ Cancel

Size: 11 K

Select the desired file for artwork importation.

Its save format is displayed in the dialogue box.

A double click on a file name will import the art

from that file into the activated picture box.

A single click on a file name, then a single click on

the
"open"

button will also import the file.

The picture box from the Quark document should now

be displayed with the imported art in the picture box.

Hints: What Has Happened

The Scanning
Process

The scanner digitizes the image into a series of pixels by

converting light energy to electric signals. A light is

passed over the image and the reflection of the light from

the image is passed through a photoreceptor. The

photoreceptor converts the light into an electric signal.
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The intensity of the electric (analog) signal
determines

the level of grayness of the pixel (digital information)

created.150 Each pixel is comprised of a matrix of dots

that are turned on or offby the laser scaiming device. The

perceived grayness of the pixel formed by the dots depends

upon the number of dots turned on or off. For example, a

matrix of 4 x 4 yields 16 dots, thus 17 levels ofperceived

grayness are
possible.151

nnnn nnnn nnnn nnnn nnnn onop
DnCD CDBD DDBD DBBD DBBD DBBD

ddod nnnn oaon nann obbo obbd

nnnn nnnn nnnn nnnn nnnn Dnnn

nnna bogb boob bddb bddb bddb

DBBD DBBD DBBD BBBD BBBB BBBB

DBBn GBBG DBBD HBBD OBBD BBBD

BDDD BDDD BDDB BDDB BDDB BDDB

BDDB BDDB BDDB BBDB BBBB

BBBB BBBB BBBB BBBB B BB

IBB BBBB BBBB BBBB BBBB

BDDB BBDB BBBB BBBB BBBB

The output device has a set number of dots it is capable

of printing, referred to as resolution. Since the
resolution

of the device remains constant, if the screen ruling

becomes finer, less levels of gray are possible. Conversely,

more levels of gray are possible with coarser screen

rulings. The number of dots is constant but divided

differently. Once the image is in digital form it can be

converted into a number of save
formats.152

Halftone Output The Halftone Output option is intended for low resolution

laser printers. When Halftone Output is selected a

halftone screen suitable for the scan resolution indicated

is generated during the scan. The creation of a halftone

screen from gray scale information as it is being scanned

is an involved mathematical process. It ultimately

eliminates successful modification of the image after the

scan, including
scaling.15^

Halftone Output

with EPSF

This combination gives the closest representation of the

original when outputting on a laser printer. Advantages

and disadvantages are:

Memory and time requirements usually associated

with EPSF files are not as cumbersome when using

Halftone output. Screened grayscale information

requires less memory than pure grayscale informa

tion. The quality of the output is worth the memory

this format uses.
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Scaling must be done during
scanning.154

The scanning process tends to exaggerate high

contrast originals and darken shadows.155 Since no

loss in tone occurs when importing this type of scan,
tone compensation may be needed in MC View

before scanning to compensate for darkened shadows.

The screen display is illegible, eliminating soft proof

ing. Placement is possible only by aligning edges of

the imported file with edges of the picture box.

Proofing can be time intensive. To make changes

and proof those changes, the image must be rescanned

with the changes, saved, reimported, then printed.

Contone Output When Contone Output is selected a PostScript screen is

generated duringprinting. Since the halftone screen is

generated later, the scanned image is pure gray scale

information. The altered and saved file is translated into

a screened image only when the file is sent to the printer.

Therefore screening decisions may be made at the point

of printing. The image may be modified in MC View and

Quark after the scan.156

Contone Output This combination is the best overall selection when the

with TIFF image files need extensive modification. The advantages

Uncompressed and disadvantages are:

All ofMC View and Quark's modification options are

available after scanning and
saving.157' 158

The screen display is very good, allowing convenient

soft proofing when modifying and placing the image.

A signifigant overall loss of tone occurs when a

Contone file is imported into Quark. Tone compensa

tion can be made in MC View or Quark.

The halftone screen is less noticable than with

EPSF output, when outputting on a laser printer.

Contone files require more memory than halftone

files because pure gray scale information is saved.

However Contone, TIFF Uncompressed files
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require approximately
one-half the memory require

ments of Contone, EPSF files.

Contone Output This combination is the best selection if the output
device

With EPSF is high resolution and fine screening rulings are
desired.

Advantages and disadvantages are:

The file may be modified after
the original scan, before

the EPSF save. Files cannot be altered (except scaling)

in MC View or Quark once saved as
EPSF159- 16

An overall loss of tone occurs when a Contone file is

imported. Compensate before saving as EPSF.

The screen display is illegible, eliminating soft
proof

ing. Placement is possible only by aligning edges of

the imported file with edges of the picture box.

Hard proofing can be time intensive. To
make changes

and proof those changes the image must be rescanned

with the changes, saved, reimported, then
printed.

The halftone screen is sharper in an EPSF file,

making it highly visible in output from a low resolu

tion printer. The EPSF format should be reserved

for high resolution output where finer halftone

screening is possible without sacrificing gray
levels.

Contone files require much more memory and print

ing time than halftone files because pure gray scale

information is saved. The EPSF format is also

memory intensive. A Contone scan with the EPSF

save format is the most memory intensive

combination.

The TIFF Format TIFF formats are scanner formats. These formats
"tag"

the image data, rather than leaving it in rasterized (bit

mapped) form, thus the name Tagged Image File Format

(TIFF). There are several types ofTIFF formats. The

formats differ by the amount of data compression that

takes place when saving. Data may be compressed for

storage and transmission, but is then uncompressed for

display and output. Images with gray scale information

such as continuous tone and halftone images do not work

well with data compresson. Do not compress TIFF files.161
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TIFF files display a low resolution representation of the

image on screen. This screen format has smaller memory

requirements and is saved with the Quark document

after it is imported. The high resolution information is

retained in the original file. This high resolution informa

tion is accessed from the original MC View file when the

Quark document is printed.162

The EPSF Format EPSF is the most memory intensive format. Information

is stored as mathematical equations instead of in pixel

form. This allows for greater precision and is considered

an object-orientated format.163 EPSF actually creates

two formats. Both formats are contained in one file,
displayed by one icon when viewed on the desktop. One

format is seen on the screen and the other is seen as the

printout when using higher resolution devices.

The first format is a PICT format, which is the
"preview"

picture seen in the picture box on the screen. This PICT

format file is used by Quark for placement, scaling, and

cropping. It is not a good representation of the output

because it cannot display gray tones. Therefore the display
is often predominantely black with great loss of detail. It

is also the information which low resolution non-

PostScript printers (such as ImageWriters) use to print.

The PICT format has smaller memory requirements and

is saved with the Quark document after it is imported.164

The second portion of the file is the PostScript format.

This is the more accurate output printed by PostScript

printers. The PostScript information is not saved with

the Quark document, but is accessed from the original

Illustrator file when the Quark document is printed.165

Hints: What To Look For

Get Picture IfGet Text displays under the File menu instead of

Display Missing Get Picture then:

A text box is selected. Deselect the text box and

activate a picture
box.166

IfGet Picture is shaded instead of solid then:

The wrong tool is selected. Activate the edit
tool.167
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Desired Files If the desired MC View file does not display in the Get

Missing from Get Picture dialog box then:

Picture Display The file may reside in a different folder or it may

not be resident on the hard disk or floppy disk.

Use the Find File function found under the Apple

menu to locate it. If the file is not found then it

must be installed on the hard disk or diskette.

The file may be saved in the wrong format. The

Get Picture dialogue box will only display files

that are in an accepted format for importation.

(accepted but not necessarily suitable format) Find

File will locate, but not display the save format.

Close the Quark file and quit the application. Go

to the location (using Find File) and look for the

TIFF or EPSF icon with the appropriate file name

in the window. The TIFF icon will not indicate

whether it is uncompressed or a compressed version.

MC View TIFF icon I MC View EPSF icon

If the format is incorrect, a double click on the icon

will open the file so that the save format can be

changed (the application must be resident).

However the
"new"

save can only convert informa

tion available from the
"old"

save. It may be

necessary to rescan the image to regain essential

image information that the
"old"

save did not save.

Also, EPSF formats cannot be resaved as other

formats. Refer to pages 8389 for more specific

examples of resaving to other formats.

Blank Picture If the X inside the picture box disappears but the

Box on Screen picture box is blank then:

The picture has been imported but its visible

portions are not centered in the picture box. Use

S
shift-M to automatically center the picture

within the picture box.168

The edit tool may also be selected. The hand portion

of the tool will be activated and the picture can be

moved by
"sliding"

it with the hand.169
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Imported Files If the following dialogue box appears when attempting
Modified or to print then:

Missing

A
Some disk files for pictures in this document hai/e

been modified or are missing.

List Pictures^) | Print flnymay)) [ Cancel Print ]

Go to List Pictures to determine if the problem is

missing or modified pictures. Another dialogue box

will appear listing the file name of the artwork,
page location, format of the file, and the missing or

modified status.170

Missing or Modified TIFF/RIFF/EPS Pictures

Name Page Type Status

EPS Logo

Paint Brush

Sunset.TIFF

I EPSF Modified

I EPSF Missing
1 TIFF Missing

O

o

Print ~J ( Cancel Print ]

Modified Picture If the picture has been modified then:

When outputting in PostScript, the modified

MC View file will be accessed for the printout. The

message serves as a warning because the screen

preview has not changed unless the picture has

been reimported.171

If it is necessary to view the modifications on screen,

then reimport the MC View file using Get Picture.

Missing Picture If the picture is missing then:

Select the missing file from the Missing or Modified

dialogue box, then select Find. Quark will locate

the file and reestablish the path so it may be

accessed for output. It does not reimport the file so

the screen preview remains the same.17^

The artwork can also be imported again under Get

Picture.173
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The dialogue box is a warning that the output will

be low resolution (provided a screen preview has

appeared in the picture box). Quark is not able to

find the original file of the artwork. Since Quark

saves only the file name of the TIFF file or

PostScript portion of the EPSF file, it must be able

to locate and access the original file in order to

print the TIFF file or PostScript. When it cannot

find the original file it outputs in the screen format

that was saved as part of the Quark document.174

Files become missing because specific conditions must be

observed to enable Quark to locate the original files:

If the Quark document is moved to another system,

the original file must be moved to that system.175

The name of the original filemust remain the same

as the name used when importing the artwork.

Quark will search for the original Get Picture

name and will not recognize a new
name.176

The sequence of the folders that Quark needs to

access to locate the original file is the called the
"path."

The path names and their sequence must

remain the same as in the original Get Picture.177

Quark will search in the Quark document folder if

the original path has changed. If an original file

needs to be moved, relocate the file in the Quark

document folder so Quark can find it.178

EPSF PostScript If after importing a EPSF file the following message
Message appears in a gray shaded picture box then:

PostScript Picture

(title of file)

The PICT format is too large for screen viewing
and has not been imported. The PostScript will be

accessed for output if a PostScript printer is used,
but the PICT portion of the EPSF file is not

available for screen viewing or bitmap output from
low resolution printers.179
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Font Substition

Within the

Imported EPSF

File

If the following dialogue box appears when attempting
to print then:

A
Note: Some EPS pictures in this document contain

fonts not available in your System, including:

Bodoni-Bold

Print flnymau [ Cancel Print ]

An imported EPSF file contains screen fonts

that are not available on this system. Quark

assumes that the printer font is also not available

and displays the warning. This could occur if type

is added to a scanned file in MC View.

The System file may be checked for the possible

missing printer font or select Print Anyway. If the

printer font is not available Quark will substitute

Courier for the missing
font.180

If the printer font is not resident the screen fonts

and printer fonts must be installed into the

system.

Illegible Screen If an imported image appears nearly all black and

Display, illegible on the monitor but the output is good then:

Good Output It is saved in the EPSF format. The screen preview

is very poor, but is normal. This format cannot be

changed. Rescan if another format is desired.

Magnified

Display and

Output

If the imported image appears very dark with large

pixels on the monitor and when printing then:
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Missing Midtones

The Paint format was selected when saving a Half

tone scan. Only a portion of the image was saved

because the image has been greatly magnified.

Rescan the image to regain all image information.

Save in the EPSF format if it is a Halftone scan, or

in TIFF Uncompressed or EPSF formats if it is a

Contone scan.

If an imported image is black and white with no

midtones then:

Line art Output was selected as the scanning format

or Contone Output was selected but the graymap

control was set to eliminate midtones. The image

must be rescanned as Halftone or Contone Output

to regain gray scale information.
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Jaggy Display If the imported image is jaggy but legible on the

and Output monitor and jaggy but much lighter in tone when

printing then:
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Halftone Output and TIFF Uncompressed were

selected as the scanning and saving formats. Open

the file and resave as the EPSF format under Save

As. The tone loss occurs when the file is imported

into Quark in the TIFF format (Halftone Output),
but will not occur when importing the EPSF format

(Halftone Output). Since the original TIFF file is

not affected, tone compensation is not necessary.
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LOSS Of Overall If the output is too fight after importing and if the file

Tone is a Contone, TIFF Uncompressed then:

(Contone scan,

TIFF format)

The loss of tone occurs with the import ofContone

files in both the TIFF and EPSF formats. The

original files do not reflect this loss of tone. Adjust

the tone curve in Quark ifpermanent changes to

the image file are not necessary. The tone curve

may be altered in MC View if the file is to be used

in the future and permanent changes to the image

are desired.
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Loss of Overall

Tone

(Contone scan,

EPSF format)

If the output is too light after importing and if the file

is a Contone, EPSF then:

The loss of tone occurs with the import ofContone

files in both the TIFF and EPSF formats. The

original files do not reflect this loss of tone. The

tone can only be altered before the EPSF save.

Rescan the image, compensate for tone, then save

in the EPSF format. The image must be hard

proofed because of poor monitor display. This can

be a lengthy process. Not only are many steps

required but EPSF files are the most memory

intensive and take the longest to save, import,
and print.
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Visible Scan

Lines on Display
and Output

If the image is darkwith scan lines clearly visible then:

The original was a halftone, Line art Output was

the scaxming mode, with Contone to Line art

option selected, and a TIFF save format selected.

Rescan the image as a Contone or Halftone scan.

Save in the EPSF format if it is a Halftone scan, or

as EPSF format or TIFF Uncompressed if it is a

Contone scan.

88 The Integration Training Module



If the image has a contrasty, posterized look with a

waffle type texture then:

nee upon a time, not so very 1<

part ofWest Germany know

The original was a halftone, Line art Output was

the scanning mode, with Contone to Line art

option selected, and the EPSF save format

selected. Rescan the image as a Contone or

Halftone scan. Save in the EPSF format if it is a

Halftone scan, or in TIFF Uncompressed

or EPSF format if it is a Contone scan.
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MC View Won't If the followingmessage appears when attempting to
Address File open aMC View file from the desktop then:

The file is in the EPSF format, which MC View

cannot open. The EPSF file may be viewed

through a picture box after importing into Quark.

Since no modifications can be made to this file,
except scaling in Quark, itmust be rescanned if it

is not acceptable.

If opening from MC View the files will not be

displayed for selection.

Moire Patterns If signifigant moire pattern appears then:

The Descreen option may not have been selected

during the scan. The halftone screen of the
original image is creating a moire pattern when
the printer halftone screen is added. Rescan with
Descreen selected.
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Scaling Halftone If an imported Halftone image has been scaled then:

Outputs If the image is scaled larger, the screen is scaled

larger also, making it appear coarser and more

visible. This makes the image appear lighter in

overall tone.

If the image is scaled smaller, the screen is scaled

smaller also, making it so fine that detail fills in.

The image appears darker in overall tone.

Original size

Scaled at 200%

Halftone Output scans should be scaled at the

time of the scan.181 Rescan the image after

determining the proper scaling.

uce upon a time, not so vcr? lonj
iput ofWen Germany Imovn i

I Saxony , a prince of an and his
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Considerations: Before and After Integration

Although many of the functions and tools in Quark and

MC View are specialized and unique to the particular

program, several may appear to overlap or handle

similiarly The user is faced with the decision in which

program to apply the overlapping functions. The reasons

to work in one program over another vary. They depend

uponwhether both programs are available for use, whether

the programs can address the save format of the file, the

results desired, and differences in how the similiar

functions work. Overlapping functions and tools from

Quark and MC View are discussed in the following pages.

Halftone When looking atMC View and Quark there appears to be

Screening a number of locations where screening selections may be

made. Screening options are offered in the following
locations:

MC View Plus:

Scanning dialogue box (Halftone Output only):

LaserWriter dot

Display dot

P400PS dot

Line 45

File menu (all scanning outputs)

Page Setup: Proofprinter

Page Setup: EPSF file

QuarkXpress:

Style menu (not available for EPSF formats):

Normal

60Line Line
Screen/O0

30-Line Line Screen/450

20-Line Dot
Screen/45

Other Screen user defined screens

File menu:

Page set up user defined lpi

The user wonders where the best place is to make the

screening selection, which selection takes precedence,
and how it will affect output. In actuality, the user has

very few choices to make for this function. The selections

actually available depend upon the scanning output

selection and the save format. The key is to sorting out
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which selections take precedence, even when various

menus are active and appear to make options available.

Screening for The Halftone Output scanning mode generates a halftone

Halftone Output screen during the scan. Therefore a screen must be select
ed before the scan. When the scanning dialogue box

appears the user must select the type ofhalftone screen

to be used: LaserWriter dot, Display dot, P400PS dot, or

Line 45. The scan resolution should match the resolution

of the laser printer being used for output. The scanner

automatically creates a halftone screen, with gray levels

suitable for the resolution of the laser printer, while

scanning.
182

All other screen options may be ignored in MC View and

Quark. This file's screening information overrides all

other screening options in MC View or Quark, when in

the recommended save format, EPSF.

Screening for

Contone Output

Proof Printing
Files in

MC View

Printing Files in

Quark:

Contone, TIFF

Uncompressed

The Contone Output scanning mode saves pure grayscale

information. A halftone screen is not generated until the

file is sent to the printer. Therefore screen selections

depend upon the application from which the file is being
printed or the save format of the imported image.183

Screen selections must be made in MC View if proof

printing from MC View. Set screen preferences by pulling
down the File menu and selecting Proof Printer from

Page Setup. All Contone files printed from the MC View

application will display the selected proof printer screen.

Screen information does not come over with imported

TIFF files, only grayscale information. Quark sends the

screening requirements to the printer, so screen selections

must be made in Quark.

When Quark imports TIFF images, the Style menu will

be active. Several preset screens are available, as well as

Other screens, which allows the user to define the screen

parameters.184 The lpi of the Normal screen option is

also user defined. It may be changed by selecting Page

Setup under the File menu. Find the Halftone screen box
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Printing Files in

Quark:

Contone, EPSF

and type the number of lpi desired, then click on Okay.

Only the lpi of the Normal screen will be
changed.

Since EPSF files cannot be altered once saved, the screen

selection is made inMC View and that screen information

is saved with the image file. Quark cannot alter the

screen information that has been imported with the EPSF

file. The screen is denned in MC View by selecting Page

Setup under the File menu, then selecting
EPSF file

from the pull down menu. The image must be rescanned

if the original screen selection needs to be changed.

Note: The user may change EPSF file screen selections,

proof print, and wonder why the Proof
printer selection

takes precedence when printing EPSF
images from

MC View. The reason is the file may have been saved as

EPSF, but has not been closed. TIFF is a scanner format

and the TIFF information is not converted to EPSF until

the file is closed. The proof print is a representation of

the original scanner format TIFF Uncompressed. EPSF

files cannot be reopened in MC View once they have been

closed because MC View does not address the EPSF

format. However, once the EPSF file has been saved and

closed, the EPSF screen information has been irrevocably

saved with the file.

Type of

Scanned File

The following chart will aid users in making the

screening selections in the appropriate location and at

the proper time.

Where to Select a Halftone Screen

Halftone Output

EPSF

Contone Output

TIFF

Uncompressed

EPSF

MC View Plus

Must select before scanning from

Scanning Dialogue Box

Select from Page Setup:

Proof Printer (File menu)

if printing from MC View

Select from Page Setup:

EPSF File

if printing from Quark

(the screen is saved and

imported with with the file)

QuarkXpress

Not available for EPSF

Select from Style Menu

if printing from Quark

Not available for EPSF
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Scaling Scaling must be done in MC View when scanning. It is

Halftone Output important to know the final image size before scanning
so the proper calculations can be made for the scan.185

Contone Output Scaling may be done in MC View when scanning or in

Quark, regardless of the save format. The quality of

scaling will be the same from both programs. In both

programs scaling smaller will result in a loss of resolution.

Scaling larger yields some distortion.186 Excessive

scaling should be avoided.

In MC View, time is saved by scaling during the scan, but

the final image size must be known. If the final image

size is not known then scaling in Quark is the only option.

However scaling in Quark allows the results to be

displayed on the screen immediately. This permits changes

to be viewed quickly when playing with layout sizes.

Ifmemory requirements are the primary consideration,

especially for the memory intensive EPSF format, the

choice of programs would depend upon the size of the

final image. When scaling larger in MC View more

memory is used and the better choice may be to scale in

Quark. The opposite would be true of scaling smaller.

Quark also allows disproportionate scaling, which is not

offered in MC View.

Duplicating In Quark, the entire picture box and its contents are

duplicated using the Items menu Duplicate function.

Multiple duplication is possible with the Step and Repeat

function. This function controls quantity and placement

of the duplication in equal increments horizontally
and/or vertically. Once duplicated, the boxes are separate

entities and can be arranged independently.

Duplicating images in MC View is not always feasible. It

is actually a cutting and pasting operation, and should be

used when individual elements need to be duplicated. The

duplicated elements and their placement become part of

the image file. If the entire image must be duplicated in

MC View there must be enough white space to hold the

copied image, since what is underneath will be replaced.
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The quality of the duplications
will be the same from

both programs.

Text and Rules In general the same advantages and limitations apply to

text and rule tools. Quark is the more versatile program

to work in when using these tools. MC View's range of

options for these tools are limited.

In MC View text and rules become part of the image file

and cannot be separated from the image. When the text

and rules are active theymay be moved and placed within

the image file. However, once they are no longer active,

they become part of the image and the information under

neath is lost. So cutting and pasting to move text or
rules

to another location will leave a blank hole at the original

location.

In Quark, text and rules are separate entities and not

part of the image. Text is contained within text boxes,

and text boxes and rules may be moved for placement at

any time without disturbing the image underneath.

Although the text boxes and rules are not part of the

image, they may be locked in place so that the picture

box and its contents can be treated as a whole unit.

Contrast or Tone

Compensation

Controls

Halftone Output,

EPSF

Contone

Output, TIFF

Uncompressed

When looking at MC View and Quark there appears to be

a number of locations where contrast or tonemodifications

may be made. However the availability is dependent

upon the scan output and save formats used.

Tone compensation is only available before scanning in

MC View in the scanning dialogue box. The user selects

tone curves by choosing options such as Light original,
Dark original, Brighten shadows,

etc..187 Other contrast

options are not active after scanning in MC View or after

importing in
Quark.188

The important consideration when importing a Contone

file is that an overall loss of tone occurs with the import.

Contrast control is offered in MC View under the View

menu Graymap control option.189 Users can compensate

for the tone loss while still in the MC View program, but

will not see the results until it is imported into Quark.
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Although the output is similiar from both functions, it is

easier to alter the tone curve in Quark. The user can

view the tone loss, which occurred with the import, on

the monitor in Quark and can view adjustments

immediately. Quark offers extensive modifications

options under the Style menu Contrast option.190

Contone Contrast modifications must be made in MC View before

Output, EPSF the file is saved and then closed in the EPSF format,
because files cannot be altered once converted to the

EPSF format.191 Before the file is closed it is still in the

scanning format TIFF Uncompressed. The conversion

from TIFF to EPSF takes place when the file is closed.

MC View will not address the file once it is closed.

Contrast control is offered in MC View under the View

menu Graymap control
option.192 The same loss of tone

that occurs with the Contone TIFF Uncompressed import

will occur with the EPSF format. Users can compensate

for the tone loss while still in the MC View program, but

will not see the results until it is output from Quark.

Quark will not activate its Style menu (where the

contrast controls are located) to EPSF files.193 The image

must be rescanned, modified, saved and closed, imported,
and output until the desired results are achieved.

Importing Halftone Images from MC View Plus 97



98 The Integration Training Module



Importing Scanned Images from MC View Plus:

Halftone Charts,

Graphs, and Diagrams

Save Format for Integration

Considerations When scanning and importing charts, graphs, or diagrams

the original images will be in one of three forms line art

(black and white tones only), continuous tones (gray tones),
or halftones (simulated gray tones). It is the nature of

charts, graphs, and diagrams to contain a quantity of

line work. Therefore these types of images import and

reproduce better if treated as line art when scanning.

It may be desirable to retain the shaded areas in charts,

graphs, and diagrams that are found in continuous tone

and halftone originals. However, in order to simulate

gray tones, the printing process requires screening of the

image. When these types of images are screened the

quality of the line work in the file is very poor. Although

the gray tones in continuous tone and halftone originals

will be converted to white or black during a line art scan,
Line art Output remains the best scanning choice. The

user may add a variety of patterns to selected areas of

the image to simulate gray tones after the scan in

MC View by using modifying functions and tools.

More than one save format is available for scanned line

art. The format selected depends upon several factors.

They are:

Modifications:

Are MC View modification options necessary?

Are Quark modification options necessary?

Screen Viewing:

Is a good screen representation necessary?

Output resolution:

Low resolution Laser printer (under 1000 dpi)

High resolution output Typesetter quality

(over 1000 dpi)
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The proper save sequence in MC View Plus for line art

involves choices from three separate options. The three

options and the selected choices are:

Scan selection option: Line art Output Manual

End application option: QuarkXpress

Save format option:

TIFF Uncompressed if Quark's Style menu

options (shade, color, and screening) are required

or if output is laser printer resolution.

Line art Output,

Tiff Uncompressed,

Maximum Threshold

EPSF ifQuark's Style menu options are not

required, and output is high resolution.

I Average cone. Highest cone. -*- 1 7.5 ppm limit

D3 D4

FURNACE

D5 D6

How to Save in MC View Plus

Line art Output is selected before the initial scan in

MC View Plus under the Scan menu.194 A V will be
placed next to the selected output. It is important that

the file be scanned as line art since Quark treats TIFF

line art differently than other TIFF files.195Scan Selection

?Line art Output

Halftone Output

Contone Output

Scan Menu

Select Line art Output

A pull down menu is available in the scanning dialogue

box for Line Art.196
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SelectManual

Output Resol.

should match

printer resolution

Deselect-

Adjust for
images'

Set at
0"

Line art Output,

Tiff Uncompressed,

Maximum Threshold,

Pixel edited.

Patterns added

with Paint bucket

Line art

Output Resol. | 100 dpi

Output Size %

Threshold

"? Automatic density control

m .-.: 1*1nap
[[Scan Window ij

Sharpness [JJ ^ [
:

mm Cancel

Select Manual from the pull down menu. The output

resolution should match the resolution of the printer.197

Deselect Auto Density Control when in the scanning
dialogue box. This allows manual selection of the

Threshold setting. The Threshold setting determines the

density at which dots become black or white. By

adjusting the Threshold, undesirable
"background"

matter can be dropped out of the scan.198

Experimentation will determine the optimum Threshold

setting for particular images. Continuous tone or

halftone originals will require higher settings, such as

40-50, to convert all the gray tones to white.

Shaded areas can be added by usingMC View Pattern

menu. Pull down the menu, select Transparent, then

select the Fill pattern desired. Go to the tool box and click

on the paint bucket. Place the paint bucket tool over the

area in the image to be filled. Each enclosed area must

be filled separately.

I Average cone. Highest cone. -*- 17.5 ppm limit

D1 D2 D3 D4

FURNACE

D5 D6
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Note: Pixel editing is usually required for the fine
work

contained within charts, graphs, and diagrams.

End Application After the scan select Save as under the File menu. This

displays End application options from which the target

program, XPress (Quark), is selected from the submenu.199

Select XPress

(Others and MC
View-

will work also. They

display the same

format options for

Line art Output)

|Q Scanner]

O Mcuieujl.la3

-. MclHeu>Plut(.t

? McUieujPlusl.lb3f

McMetuPlutllLO

tied- 1

Others

MacDraw

PageMaker 2.0

PageMaker 3.0

zfflBimn
RagTime 2.0

RagTime 3.0

^HPress J.I

sfc-HPresj 2.0

sHO

-s
I1246K free

DC

McUlew 2.0

MacDrauJll

Manew 1.0

ReadySetEo 4.0a

mageStudio 1.5

Illustrator 1.0,1.1

Digital Darkroom 1.0

FreeHand 1.0

FreeHand 2.0

File info

Save Formats

Give the file a

descriptive name to

help identify
it-

Select Tiff

Uncompressed

or
EPSF"

TIFF

Uncompressed

By selecting Quark as the end application, only the

formats that Quark will accept will be displayed in the

Format submenu.200 IfOthers is selected the submenu

will display all ofMC View Plus's saving formats.

Q Scanner!
J Pierre s HO

. Mciileu>Plm!.l

Q McUieujPlus1.lb3f
'. MeLlieu'Pluvlll.D

O

o

E)e<l

Dnue ) 12994 K free

| Saue 1

Cancel j [ File Info

ilnlitled-8268

McUieui2.0]

Saue as :

End application

Format | 1 1 1 1 UllUJIIiumte*

i Info

use this to retain the most informat

VTiff uncompressed

Picture

non-compressed

Paint

EPSF

1 TlffLZHi

Select TIFF Uncompressed if the output is a low

resolution laser printer or Quark's Style menu options

are required (shade, color, and screening). Modifications

may be made to this file before and after the save. This

may be important for this type of image that requires so

many modifications (especially if shaded areas are being
added.
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EPSF Format Select EPSF if the output is a high resolution device and

Quark's Stylemanual options are not necessary. There is

no noticable difference between TiffUncompressed and

EPSF when printing from a laser printer. Since EPSF is

memory intensive, select this format only if the output is

high resolution. Once a file is saved in the EPSF format

no modifications may be made to
it.201 Therefore changes

in MC View are restricted to before the save and Quark

modification options (except for scaling) are eliminated.

Note: If the format is selected before the end application,

and it is not appropriate to the end application, then the

format will jump to another selection. By selecting the

end application before selecting the format the problem of

the format jumping around will be eliminated. Unnoticed

format changes may adversely affect the Quark import.

How To Import Line Art into QuarkXpress

Select the editing tool from the tool palette and click.

The selected tool will become a negative image.202

w

Create a new picture box or activate a current picture

box with a single click of the mouse.203

l3
-? I

Select Get Picture under the File Menu.

Get Picture can only be selected if a picture box

and the editing tool are
activated.204

New... XN

Open... XO

Close

Saue XS

Saue as...

Reuert to Saued

Get Picture

Saue Tent ...

Get Document...

Page Setup...

Print... XP

Transfer... XT

File Menu

Select Get Picture

Importing Line Art from MC View Plus 103



The Get Picture dialog box will appear.

Ifyou are in a file, it fists the files and folders that

can be imported into Quark from the location

(hard disk or floppy disk) where you opened this

file. Ifyou are in a folder at either location, it fists

the files in that folder.205

A double click on a folder name will open that

folder to show you its folders or file names. Folders

can be inside folders so double click until the

desired file is found.

Dialogue box name-

Folder on hard drive-

File inside folder -

(double click to

import)

Folder inside
folder-

(double click to

display files)

Location'

Save
format"

To change location, one click on the
"drive"

button

transfers you between the diskette and hard disk.

Get Picture

Q File Plcts|

-Hard Disk

( Eject 1

Driue

Open

Cancel

Size: 11 K

Select the desired file for artwork importation.

The file's save format is displayed in the dialogue

box for easy verification.

A double click on a file name will import the

art from that file into the activated picture box.

A single click on a file name, then a single click on

the
"open"

button will also import the file.

The picture box from the Quark document should now

displayed the imported art in the picture box. The

imported picture replaces any picture that was previously

placed in the box.
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Hints: What Has Happened

The Scanning The scanner digitizes the image into a series of pixels by
Process converting light energy to electrical signals. A light is

passed over the image and the reflection of the light from

the image is passed through a photoreceptor. The

photoreceptor converts the light into an electric signal.

The intensity of the electric (analog) signal determines
the level of grayness of the pixel (digital information)
created.206 Once the image information is in digital form

it can be converted into a number of save formats.

Line art Output By selecting Line art Output, MC View takes a level of

gray and converts all darker readings to black and all

lighter readings to white. The result is each pixel is either

black or white.207 The gray level can be set automatically

or manually (threshold option) for more
control.208

The TIFF Format TIFF formats are scanner formats. These formats
"tag"

the image data, rather than leaving it in rasterized (bit

mapped) form, thus the name Tagged Image File Format

(TIFF). There are several types ofTIFF formats. The

formats differ by the amount of data compression that

takes place when saving. Data may be compressed for

storage and transmission, but is then uncompressed for

display and output. Line art works well with data
compresson.209

If a TIFF format is selected for importation into Quark it

must be scanned as fine art.210 Because line art does not

usually require a great deal ofmemory, TIFF Uncompress

ed has been selected as the format of choice. However,

Line art in compressed TIFF formats import with no

noticable difference in output. The TIFF formats offered

by MC View for importing into Quark are listed below in

ascending order ofmemory requirements:

TIFF CCITTStandard format with high data

compression

TIFF Packbits Standard format with single data

compression

TIFF Uncompressed Standard format without

data compression211
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The EPSF Import EPSF is the most memory intensive format. Information

is stored as mathematical equations instead of in pixel

form, then converted into pixel form at the printer. This

allows for greater precision and is considered an object

orientated format. However files cannot be altered once

they are saved in the EPSF
format.212

EPSF actually creates two formats. Both formats are

contained in one file, displayed by one icon on the desktop.

One format is seen on the screen and the other is seen

as the printout when using higher resolution devices.

Other Formats

The first format is a PICT format, which is the
"preview"

picture seen in the picture box on the screen. This PICT

format file is used by Quark for placement, scaling, and

cropping. It is not an accurate representation of the

output. It is usually heavier with much detail filling in.

It is also the information which low resolution non-

PostScript printers (such as ImageWriters) use to print.

The PICT format has smaller memory requirements and

is saved with the Quark document after it is imported.213

The second portion of the file is the PostScript format.

This is the more accurate output printed by PostScript

printers. The PostScript information is not saved with

the Quark document, but is accessed from the original

MC View file when the Quark document is printed.214

Quark is also capable of importing Picture (PICT) and
Paint formats. A disadvantage is the Quark Style menu

is not available for these formats (and EPSF), eliminating
several useful options from Quark.215 Another dis

advantage is the Paint format cannot be scaled, has size

limitations, and becomes truncated.216

Hints: What To Look For

Get Picture

Display Missing

IfGet Text displays under the File menu instead of

Get Picture then:

A text box is selected. Deselect the text box and

activate a picture
box.217

IfGet Picture is shaded instead of solid then:

The wrong tool is selected. Activate the edit tool.218
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Desired Files If the desired MC View file does not display in the Get

Missing from Get Picture dialogue box then:

Picture Display The file may reside in a different folder or it may

not be resident on the hard disk or floppy disk.

Use the Find File function found under the Apple

menu to locate it. If the file is not found then it

must be installed on the hard disk or diskette.

The file may be saved in the wrong format. The

Get Picture dialogue box will only display files

that are in an accepted format for importation.

(accepted but not necessarily suitable format) Find

File will locate the file, but not display the save

format. Close the Quark file and quit the

application. Go to the location (using Find File)
and look for the TIFF or EPSF icon with the

appropriate file name in the window on the

desktop. The TIFF icon will not indicate whether

it is uncompressed or a compressed version.

MC View TIFF icon I
"

MC View EPSF icon

If the format is incorrect, a double click on the icon

will open the file so that the save format can be

changed (the applicationmust be resident). However

the
"new"

save can only convert information

available from the
"old"

save and EPSF cannot be

converted at all. It may be necessary to rescan the

image to regain essential image information that

the
"old"

save did not save. Refer to pages 110-112

for specific examples of resaving to other formats.

Blank Picture If the X inside the picture box disappears but the

BOX on Screen picture box is blank then:

The picture has been imported but its visible

portions are not centered in the picture box. Use

3-shift-M to automatically center the picture

within the picture box.219

The edit tool may also be selected. The hand

portion of the tool will be activated and the picture

can be moved by
"sliding'

it with the hand.220
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Imported Files If the following dialogue box appears when attempting

Modified or to print then:

Missing

A
Some disk files for pictures in this document haue

been modified or are missing.

[ List Pictures ) | Print flnymay jf [ Cancel Print J

Go to List Pictures to determine if the problem is

missing or modified pictures.
Another dialogue box

will appear listing the file name of the artwork,

page location, format of the file, and the missing or

modified
status.221

Missing or Modified TIFF/RIFF/EPS Pictures

Name Page Type Status

EPS Logo

Paint Brush

Sunset.TlFF

1 EPSF Modified

1 EPSF Missing
1 TIFF Missing

O

a

Find 3 c Print J [ Cancel Print

Modified Picture If the file has been modified then:

When outputting in PostScript, the modified

MC View file will be accessed for the printout. The

message serves as a warning because the screen

preview has not changed unless the picture has

been reimported.222

If it is necessary to view the modifications on screen,

then reimport the MC View file using Get Picture.

If the picture is missing then:

Select the missing file from the Missing or Modified

dialogue box, then select Find. Quark will locate

the file and reestablish the path so it may be

accessed for output. It does not reimport the file so

the screen preview remains the same.223

The artwork can also be imported again under Get
Picture.224
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The dialogue box is a warning that the output will

be low resolution (provided a screen preview has

appeared in the picture box). Quark is not able to

find the original file of the artwork. Since Quark

saves only the file name of the TIFF file or PostScript

portion of the EPSF file, it must be able to locate
and access the original file in order to print the

TIFF file or PostScript. When it cannot find the

original file it outputs in the screen format that

was saved as part of the Quark document.225

Files become missing because specific conditions must be

observed to enable Quark to locate the original files:

If the Quark document is moved to another system,
the original file must be moved to that system.226

The name of the original file must remain the same

as the name used when importing the artwork.
Quark will search for the original Get Picture

name and will not recognize a new name.227

The sequence of the folders that Quark needs to

access to locate the original file is the called the
"path."

The path names and their sequence must

remain the same as in the original Get Picture.228

Quark will search in the Quark document folder if

the original path has changed. If an original file

needs to be moved, relocate the file in the Quark

document folder so Quark can find it.229

EPSF PostScript If after importing an EPSF file the following message
Message appears in a gray shaded picture box then:

PostScript Picture

(title of file)

The PICT format is too large for screen viewing

and has not been imported. The PostScript portion

will be accessed for output if a PostScript printer is

used, but the PICT portion of the EPSF file is not

available for screen viewing or bitmap output from
low resolution

printers.2^
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Font Substitution

within the

Imported EPSF

File

If the following dialogue box appears
when attempting

to print then:

A
Note: Some EPS pictures in this document contain

fonts not auailable in your System, including:

Bodoni-Bold

Print flnymay f Cancel Print

Magnified

Image

An imported EPSF file contains screen fonts

that are not available on this system. Quark

assumes that the printer font is also not available

and displays the warning. This may occur if text

is added to a scanned file in MC View.

The System file may be checked for the
possible

missing printer font or select Print
Anyway. If the

printer font is not available Quark will substitute

Courier for the missing
font.231

If the printer font is not resident the screen fonts

and printer fonts must be installed into the

system.

If the imported image appears cropped and greatly

magnified on the monitor and when printing then:

The Paint format was selected when saved. Only a

portion of the image was saved because of size
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limitations. If the file is resaved in a TIFF or EPSF

format without a new scan only a portion of the

original image is available for the
"new"

save,

although the original size will return. The image

must be rescanned to regain all information. Save

the new scan as EPSF or TIFF Uncompressed.

Soft and Ifthe imported image contains gray tones and appears

Diffused Image slightly soft and diffused on the monitor, but output is

screened and much lighter then:

N1 H2 m N4

FURNACE

m

Contone Output was selected as the scanning

format. The Contone file cannot be used as line

art. The image must be rescanned, selecting Line

art Output, then saved in the TIFF Uncompressed

or EPSF format.

Although the appearance of the image on the

monitor is close to the original, the output is very

different. The image on the monitor is pure gray

scale information and is not screened. When the

file is sent to the printer a halftone screen is added

to the image. This results in poor quality line

work. When the Contone file is imported into

Quark a signifigant loss of tone occurs. Although

the monitor and the proof print from MC View

yield a somewhat acceptable image (if the user is

determined to reproduce the gray tones of the

original) the output after importing is poor.
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If the imported image appears coarsely screened on

the monitor when printing then:

A^**^*WMVVV^VVVVVVVyv%WVMM^MIA%>W^!in*^^

| 2A**<9*c0ft& gftH$t^ttn$< -H#|i|pM|n#

iHAO

Halftone Output was selected as the scanning

format. The Halftone file cannot be used as line

art. The image must be rescanned, selecting Line

art Output, then saved in the TIFF Uncompressed

or EPSF format.

The Halftone scan is designed for laser printers

and automatically generates a halftone screen,

suitable for laser printer resolution, at the time of

the scan.232 This screen is too coarse for the line

work found in charts, graphs, and diagrams and is

readily visible on the monitor and at output.

If the text in imported fine work appears rough for

monitor viewing when a different computer is used then:

?Line art Output

Halftone Output

Contone Output

The computer is readingmonitor information

differently. The System file is a different version or

a different video card is used.233
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The output matchs the monitor if the original file

is missing or cannot be accessed. Use Find in the

Missing orModified dialogue box to reestablish

the path or reimport the file.234

If the original file can be accessed, the output

matchs the original file even though the monitor

display is poor.

Considerations: Before and After Integration

Although many of the functions and tools in Quark and

MC View are specialized and unique to the particular

program, several may appear to overlap or handle

similiarly. The user is faced with the decision in which

program to apply the overlapping functions. The reasons

to work in one program over another vary. They depend

upon whether both programs are available to use, whether

the programs can address the save format of the file, the

results desired, and differences in how the similiar

functions work. Overlapping functions and tools from

Quark and MC View are discussed in the following pages.

Scaling Scaling may be done in MC View when scanning or in

Quark, regardless of the save format. The quality of

scaling will be the same from both programs.

In MC View, time is saved by scaling during the scan, but

the final image size must be known. If the final image

size is not known then scaling in Quark is the only

option. However the results of scaling in Quark are

displayed on the screen and allow for quick changes

when playingwith layout sizes.

Ifmemory requirements are the primary consideration,

especially for the memory intensive EPSF format, the

choice of programs would depend upon the size of the

final image. When scaling larger in MC View more

memory is used and the better choicemay be to scale in

Quark. The opposite would be true of scaling smaller.

Quark also allows disproportionate scaling, which is not

offered in MC View.
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Duplicating In Quark, the entire picture box and its contents are

duplicated using the Items menu Duplicate function.

Multiple duplication is possible with the Step and Repeat

function. This function controls quantity and placement

of the duplication in equal increments horizontally

and/or vertically. Once duplicated, the boxes are separate

entities and can be arranged independently.

Duplicating entire images in MC View is not always

feasible. It is actually a cutting and pasting operation,

and should be used when individual elements need to be

duplicated. The duplicated elements and their placement

become part of the image file. If the entire image must be

duplicated in MC View there must be enough white space

to hold the copied image, since what is underneath will

be replaced by the image on top.

The quality of the duplications will be the same from

both programs.

Text and Rules In general the same advantages and limitations apply to

text and rule tools. Quark is the more versatile program

to work in when using these tools. MC View's range of

options for these tools are limited.

In MC View text and rules become part of the image file

and cannot be separated from the image. When the text

and rules are active theymay be moved and placed within

the image file. However, once they are no longer active,

they become part of the image and the information under

neath is lost. So cutting and pasting to move text or rules

to another location will leave a blank hole at the original

location.

In Quark, text and rules are separate entities and not

part of the image. Text is contained within text boxes,
and text boxes and rules may be moved for placement at

any time without disturbing the image underneath.
Although the text boxes and rules are not part of the

image they may be locked in place so that the picture box

and its contents can be treated as a whole unit.
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Preparing for Output

Location of Imported Files

Text from When the Quark file is saved, text that has been imported

MacWrite becomes part of the Quark document. However the fonts

contained in the imported text must reside in the system

or in the printer, or the output will be bitmapped. The

output of the Quark document is not dependent upon the

MacWrite file being resident on the diskette or hard disk.

Artwork from

Illustrator

EPSF files, including Illustrator EPSF files, are comprised

of a PICT format for screen previewing and a PostScript

format for output. Saved with the Quark file is the PICT

portion of the EPSF Illustrator file, the EPSF file name,

and the names of the path to the original EPSF file. The

PostScript portion of the EPSF file remains in its

original
location.235

The name of the EPSF file, the names of the path, and the

path sequence, must all remain unchanged so that Quark

can locate and access the PostScript portion of the file for

output. If any of the above are changed the PICT portion

of the file will be output instead of the PostScript.236

Scanned

Images from

MC View

The graphics discussed in this module have been saved in

the TIFF Uncompressed or EPSF save formats. When

these types of files are imported into Quark the screen

preview portion of the save format is imported so that

the image may be viewed and placed on the monitor.

Saved with the Quark file is the screen preview portion

of the graphic file, the graphic's file name, and the names

of the path to the original graphic file. The TIFF

Uncompressed file, or the PostScript portion of an EPSF

file remains in its original
location.237

Preparing for Output 115



Imported The name of the graphic file, the names of the path, and

images in Quark the path sequence, must all remain
unchanged so that

Quark can locate and access the TIFF Uncompressed file

or PostScript portion of an EPSF file for output. If any of

the above are changed the screen preview portion of the

file will be output instead of the information from the

original. The screen preview is lower resolution and

usually
unacceptable.238

Storing and Transporting Files

Storage It is useful to know how much memory an image, file, or

capacity folder requires for storage and/or transport. Scanned

images, in particular, can occupy more memory than is

available for storage, manipulation or transport, depend

ing upon the available equipment. There are several

ways to get memory information depending on which

program you are in and ifyou want file information or

image information.

Hard Disk When on the desktop, to view how much memory on the

hard disk is used and how much is available double click

on the hard disk icon. The memory information will be

displayed in K units (1024 bytes) at the top of the window.

File When on the desktop, to view how much memory a file

occupies click once on the file so it is highlighted. Pull

down the File menu and select Get Info. The number of

bytes the file occupies will be displayed.

Images in When an image file is open in MC View, to see how much

MC View memory an image occupies pull down the File menu and

select Get Info. All picture information will be displayed.

Importing When in Quark, to view how much memory an imported

Images image will occupy pull down the File menu and select

Get Picture. Click once on the desired image file. In the

lower right corner of the dialogue box the K units (1024

bytes) of the file will display.

Transporting The normal Macintosh two sided, double density (2S-2D)

Files floppy disk has 800K memory capacity. This is usually

Diskettes sufficient for text files and files containing line art.
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Hard disks

Magnetic Tapes

CD WORM

Optical Disks

Internal hard disks are fixed components of the computer.

Information stored on the internal hard disk is not

portable. Informationmust be copied to an external hard

disk, a diskette, or other portable storage devices

depending upon the memory requirements.

A separate external hard drive is required to hold

external hard disk cartridges for transportingmemory
intensive files that won't fit on diskettes. Typical

cartridges for external hard drives are 44MB (44,000K),
or the equivalent of 55 diskettes.239

Magnetic tapes are for archiving only and do not have

the capability to search and find information. Retrieval

of informationmust be done sequentially. Storage

capacity is approximately 200MB, or the equivalent of

250 diskettes. Special drives are necessary.240

CD WORM stands for Write Once Read Many. These CDs

are suitable forpermanent archiveal storage only. When

information is written onto the disk it is
"burned"

into

the disk and cannot be altered. However it may be

accessed and read many times. Storage capacity is

generally 512 MB, or the equivalent of 640 diskettes. A

specialized drive is required to operate this type of CD.241

Note: CD ROMs are also available but are Read Only.

They cannot write (copy)
information.242

Information may be written and edited on optical disks

in the same manner as hard disks or floppy disks, but they
operate slower than hard disks. Storage capacity is

approximately 600-700MB, or the equivalent of 750-875

diskettes. Optical disks require specialized drives that are

not compatible with hard disks, CDWORMs, or CD
ROMS.243

Effects of Output Resoluton

The user is faced with numerous choices and selections

when scanning. Although this module is not intended to

instruct the user in scanning techniques, some basic

factors to keep inmind are the interrelationships between

scanning resolution, gray levels, and output resolution.
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Line art Output When scanning line art, resolution is the key factor. The

scanning resolution should match the
output resolution.

This ensures the maximum information that the output

device can print is captured.244

Halftone output When scanning in the Halftone Output mode, scanning

resolution should match the output resolution. The

scanner automatically generates a halftone screen based

upon the scan resolution.245 The greater the scan

resolution, the more gray levels possible. Do not exceed

the resolution of the output device.

Contone Output Gray levels and screen rulings are key factors for Contone

Output. Given a set resolution for the output device, as

screen rulings increase, gray levels decrease. The reverse

is also true; as screen rulings decrease, gray levels

increase. The minimum number of gray levels considered

acceptable are 64. To print 64 gray levels on a 400 dpi

laser printer, a 50 lpi screen must be used. This is

considered newspaper quality. Finer screen rulings are

possible as the resolution of the output device increases.246

Note: As scanning resolution and gray levels increase so

does the amount ofmemory required to store the file and

the computer processing time. Users need to consider

these factors as well as the end use of the image before

making scanning
decisions.247

How to Prepare for Output

Go to the Apple and select Chooser.

Click on the icon of the desired printer. The name

of the printer will appear highlighted in the

display box in the upper right corner if it is
available. Click on the close box to exit.248

Go to the File menu and select Page Setup.

A dialogue box will appear. Select the desired

printer from the Printer Type box. The selected

printer must reside in the Chooser on the system

that is to be used for output.249
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Page setup options that are applicable to the

selected printer will be activated. When selecting a

high resolution typesetter, options such as paper

type (paper or film), resolution, paper width, paper

offset, and page gap will
appear.250

Click on Okay to activate the new selections.

Go to the File menu and select Print.

Make selections, then click on Okay. Information

selected from the Chooser, Page Setup, and Print

is then sent to the printer.

Note: Once the Chooser and the options in Page Setup
are selected, it only necessary to go to Print, unless

changes must be made in those options.

Preparing for Output 1 1 9



20 The Integration Training Module



Glossary

Active

Application

Artwork

programs

Bitmap
-see Paint

Camera ready

Continuous tone

image

Contone Output

The following definitions are the meanings that aremeant

to be portrayed in this trainingmodule. The terms may

have other meanings and interpretations in other

contexts. Italicized terms found in the definitions are

also defined in the glossary.

By selecting an object (clicking on it), it is activated. It

may be modified or used when in the active state.

The specialized set of computer commands that control

imput data. It is sometimes referred to as a program,

although the application may only be a portion of the

total program package.

Software programs that computer-generate images.

There are two types of artwork programs. Draw or

object-orientated programs that describe shapes as

mathematical formulas, or Paint programs that describe

shapes as clusters of
dots.251

A storage format that saves graphic images as a pattern

of dots. The dots are black or white, with no gray scale

information, and may be pixel edited. Also referred to as

a Paint format. Programs using this format are called

paint programs (versus draw
programs).252

Text and graphics are in the completed form for the

camera stage of a production cycle.

An image which is not limited to black and white, but

contains shades of gray. It must be converted to a black

and white image for printing by the halftone process.

Scanning will converts continous tones
to halftones.253

A scanningmethod
format used byMC View Plus which

reads gray scale
information. A PostScript halftone
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Desktop

screen is generated when the image is sent to the printer

for output.254

An electronic display used byMacintosh to simulate

working at a desk. Some of the items
found on the

desktop are windows, menus, tools, and icons.

Desktop The DTP process brings text, artwork, graphics, and

Publishing (DTP) page layoutprograms together, eliminating separate

typesetting and image assembly functions.
Camera-

ready copy is prepared at a computer work
station.

Dialogue Box

Digitize

A box which automatically appears when the
application

needs to communicate with the user. It requires

information to continue, or it may issue warnings to the

user of the consequences of an
action.255

The process of converting analogue information into

dots.256

Disks A storage vehicle for computer information.

Hard Disks Hard disks have a great deal ofmemory and can be

internal, contained within the computer casing, or

external and portable. Portable external hard disks are

considered accessory equipment for users needing to

store or transport memory intensive files such as

scanned
graphics.257

Diskette,

Floppy Disks

Diskettes are the most common portable storage

medium. They are smaller and have limited storage

capacities for graphics but are well suited for documents

containing text. Diskettes are also referred to as floppies,

floppy disks, or disks. Macintosh uses 3
1/2" diskettes.258

Draw A storage format that saves graphics as a sequence of

see PICT mathematical commands which will draw shapes, rather

than patterns of dots (as inpaint formats). These

commands recreate shapes as lines and arcs with

directions for filling in with patterns. Draw formats are

considered object-orientated.
259 No gray scale informa

tion is possible.260
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Encapsulated A save format that uses the PostScript page description

PostScript (EPSF) language formulated byAdobe.

File A storage location for a single document, application, or
system.

Folder A storage location for single or multiple files. Folders are

convenient methods for organizing files.

Graphics Software offering image editing and camera preparation

programs for scanned images (graphics).

Gray level Refers to the number of shades of gray that may be

printed for a scanned image. The possible number ofgray

levels depends upon the output resolution and the

halftone screen ruling. For a specific resolution, gray

levels will decrease as the screen becomes finer.261

Halftone

Halftone Output

A method of simulating shades ofgray with black and

white dots ofvarying sizes.

A scanningmethod format used byMC View Plus which

reads pure gray scale information and mathematically

generates a halftone screen suitable for laserprinters at

the time of the scan.262

Icon

Integration

Laser printer

Layout

Line art

A graphic designed to symbolically represent an object or

concept.

The process of importing one or more files from one

software program into another software program.

A desktop printer that uses a computer directed laser

beam to statically charge a drum to attact or not attract

toner in the shape of the image to be printed. The toner

image is then transfered from the drum to paper.263

The designing of the appearance of a page(s), usually

incorporating text and graphics.

Original images containing only black and white

information. No shades ofgray are present to require

halftone screening.
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Line art Output A scanningmethod format used byMC View Plus which

reads information as black or white (no grays). A

threshold is automatically or manually set
and higher

values are read as black while lower values are

interpreted as white.264

Line copy Text containing only black and white
information. No

shades of gray are present to require
halftone screening.

Link A function available in Quark which allows text boxes to

be joined in a consecutive manner. Text will flow from

one text box to the next as the boxes are
filled.265

Mechanicals Camera ready art.

Menu A list of commands that can be activated.

Module A training unit that is one complete segment of a
larger

training program.

Monitor Computer viewing screen.

Object- Programs or formats that save graphics as a sequence of

orientated mathematical commands which will draw shapes, rather

than patterns of dots (such as in.paint formats). These

commands recreate shapes as lines and arcs with

directions for filling in with patterns. Object-orientated

programs and formats are also referred to as draw

programs or PICT (Picture)
formats.266 No gray scale

information is possible.267

Page layout

programs

Paint

see Bitmap

The primary function is designing pages that utilize both

text and graphics.

A save format that stores graphic images as a pattern of

dots. The dots are black or white, with no gray-scale

information, and may be pixel edited. Also referred to as

a bitmap format. Programs using this format are called

paint
programs.268 No gray-scale information is

possible.269

Paste up Placement ofgraphics and text in a layout. Paste ups can

be done mechanically or electronically.
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PICT A save format that stores graphics as a sequence of

(Picture) mathematical commands which will draw shapes, rather

than patterns of dots (as inpaint formats). These

commands recreate shapes as lines and arcs with

directions for filling in with patterns. PICT formats are

considered draw or object-orientated
formats.270 No

gray scale information is possible.271

Pixel A single picture element. Can be solid black or white to

represent line art, but usually the term pixel contains a

matrix ofdots, some turned on and some turned off to

represent varying degrees of
grayness.272

PostScript A page description computer language developed by
Adobe Systems.

Preview image The bitmap representation of the image that is viewed on

the monitor. It may ormay not be an accurate represen

tation of the final output.273

Publication Small-to-medium sized printed pieces requiring text,

artwork, and graphics. Types ofworks printed are

annual reports, brochures, advertisements, newsletters,
and magazines.

Resolution The number of dots per inch (dpi) that a particular device

is capable ofproducing to represent images. Scanners,

monitors, and output devices are described by their

resolution. As dpi increase, the resolution increases as

well. A typicalMacintosh monitor has a resolution of 72

dpi, a laserprinter is 300-400 dpi, and professional

typesetters range from 1270-2540 dpi.274

Scale Changing sizes of an object or image. Height and width

may be changed in the same proportions, or distorted by

altering height and width in differing proportions.

Scanned Graphics which have been digitized by a scanner so that

images theymay be stored and used in a computer work
environment.275

Scanner An electronic device that converts images into a series of

dots. The dots may be solid black and white to represent

line art, or the dots may contain a matrix of dots with
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Select

varying numbers of them turned on and off to represent

shades of
gray.276

To activate an item, usually by clicking or dragging in a

pull down/across motion.

Separations The film or printout that represents the amount of a

(process color) single process color present in an original color image.

Four separations are required to reproduce an original

color image, since each of the four process colors, cyan,

magenta, yellow, and black, must be represented. This

can be accomplished by photographic separation

techniques or Quark is capable of printing process color

separations.277

Separations

(spot color)

The film or printout that represents the amount of a

single flat color used as a design element. When an file

contains flat color in specified areas in addition to black

and white, then Quark can print one page for each of the

spot colors or the photographic process can produce a

spot color
negative.278

Screen The halftone technique of representing gray tones by

varying shapes and sizes of black and white dots.

The
"mesh"

that is placed over a continuous tone image

to break it down into dots.

Screen is also another term used for a computer monitor.

Spot color A flat color that is used as a design tool. A separate plate

is made for this color on the printing
press.279

Stripping The placing of graphics and line work into a page layout

so that printing plates can be made. Traditional prepress

strips film negatives into place, and electronic stripping

places electronic representations of the graphics and line

work on the computer monitor.

Template Is a temporary background image or shape used as a

guide for artwork. In Adobe Illustrator it is a PICT format

that is imported and viewed on the monitor to aid the

artist in rendering an image using Illustrator
tools.280
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Thumbnails

TIFF

Small representations of designs or pages so that an

overall concept is perceived.

(Tagged Image File Format) A format that scanners use

to represent images. The TIFF format stores gray scale

information as well as black and white line
art.281

Unlink In Quark this refers to the breaking of the chains that

join text boxes together. These links enable text to flow

consecutively from one text box to another as the boxes

are filled with text.282

Window

Word processing

programs

The viewing area from which all documents and

directories are displayed on the monitor in desktop

publishing systems.

The primary function is formatting straight text
matter.
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Appendix A

Summary of Save Formats

EPSF or EPS Encapsulated PostScript. A form ofPostScript used to

describe graphics.

Paint

PICT (Picture)

Bitmap or pixel orientated format or program.
A storage format that saves graphic images as a pattern

of dots. The dots are black or white, with no grayscale

information, and may be pixel edited. Programs using
this format are called paint programs (versus draw

programs).283

Draw or or object orientated format or program.

A storage format that saves graphics as a sequence of

mathematical commands which will draw shapes, rather

than duplicating patterns of dots (as in paint formats).

These commands recreate shapes as lines and arcs with

directions for filling in with patterns. Draw formats are

considered
object-orientated.284

PostScript A page description computer language that describes

formats pages, and describes text and graphics through

mathemetical
commands.285

TIFF Tagged Image File Format. A format that scanners use to

represent images. The TIFF format stores gray-scale

information as well as black and white line art.286

TIFF

Uncompressed

TIFF PackBits

The maximum information the scanner was able to read

and save in the TIFF
format.287

Standard TIFF format with single data compression.

TIFF data is encoded in such a way that it is compressed

for storage and transmission, but is uncompressed for

display and output. Suitable only for line art, not for gray

scale
information.288
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TIFF CCITT Standard TIFF format with high data compression. TIFF

data is encoded in such a way that it is compressed for

storage and transmission, but is uncompressed for

display and output. Suitable only for line art, not for gray
scale information.289

TIFF LZW Standard TIFF format with data compression. TIFF data

is encoded in such a way that it is compressed for storage

and transmission, but is uncompressed for display and

output. Suitable gray scale
information.290
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Appendix B

Heirarchy of Memory Terms

Bit The basic unit ofmeasurement for computers. It indicates

whether an electric pulse has been turned on or off. A bit

is always present, but is negative or positive depending
on if the signal is on or off.291

Byte A unit describing a designated string ofbits. Eight bits

are commonly found as a byte, because eight bits can

describe 256 different conditions. Aminimum of 64

conditions (gray levels) is considered necessary for

halftones, with 256 being optimum for halftone

reproduction.
292

Word (K) The unit usually manipulated at one time by a computer.

A specified number of bytes will comprise a word.

Macintosh uses 1024 bytes to a word (K).293

Megabyte (MB) The equivalent of 1000K.
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Index

Adobe Illustrator,

saving 19

Analog signal 31, 48, 76, 105

Apple 118

Auto Density Control 101

Baseline shift 17

Bitmap output 23, 35, 54, 82, 109, 115

CD ROM 117

CDWORM 117

Character spacing 13, 17

Chooser 118,119

Contone Output see Scan selections

Contrast controls,

Halftone Output 41, 49, 57, 66, 69, 77, 85, 96

Contone Output 49, 50, 58, 59, 66-67, 77, 78, 86, 87, 96-97

Convert quotes 12

Courier substitution 25, 36, 55, 83, 110

Data compression 31, 50, 78

Descreen 69, 90

Dialogue boxes,
EPS fontmissing 25, 36, 55, 83, 110

End application 28

File not supported 60, 90

Formats 28,46,74,102

Get Picture 20, 33, 47, 75, 104

Get Text 12

Missing/modified files 23, 34, 53, 81, 108

Scanning 101

Digitizing 31, 47, 75, 105

Disk,

locating files 14, 22, 33, 52, 80, 107

hard disk 115, 116, 117

floppy disk 115, 116

Duplicating,
computer-generated artwork 26

continuous tones 65-66, 95-96

halftones 65-66,95-96

line art 38-39, 114
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Editing also see Modifications of image,

text 16

Edit tool,

activating 11, 14, 19, 21, 29, 32, 46, 51, 74, 79, 103, 106,

moving the hand 22, 33, 52, 80, 107

Encapsulated PostScript (EPSF),

description 21, 32

line art 27, 29

icons 32-33

formats used 3537

End application 28, 42, 45, 70, 73, 100, 102

Files,

locating 12, 20, 24, 30, 35, 47, 54, 75, 82, 104, 109

Get Info 116

icons see Icons

Macwrite file location 14,115

Adobe Illustrator file location 22, 26, 115

line art file location 33, 1 07

continuous tone file location 52

halftone file location 80

File menu,

MC View Plus 62,63,64

Quark 11, 20, 29, 32, 46, 62, 63, 74, 103, 118, 119

Find File 33,52,80,107

Folders see Files

Fonts,

bitmap 15

EPS file missing fonts 25, 36, 55, 83, 110

missing 15

reflow 15

rendering 17

selection 16

styles 17

Footers 13

Get Picture,
Files missing 22, 33, 52, 80, 107

How to 19-21, 29-30, 46-47, 74-75, 103-104

MacWrite 13

Missing from File menu 21, 32, 51, 79, 106

Get Text 11,14,21,32

Gray levels 31, 42, 48, 63, 70, 76, 93, 105, 117-118

Graymap control 37, 56, 66, 84, 96

Hard disk see Disk

Halftone Output see Scan selections

Halftone screens,

affecting gray levels 48, 63, 76, 93, 118

Contone Output 42, 49, 50, 63, 64, 70, 77, 78, 93, 94

Halftone Output 41, 48, 62-64, 69, 76, 92-94

in MC View Plus 41-42, 62-64, 70, 92-94

in Quark 41-42, 62-64, 70, 92-94

Headers 13
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Hyphenation 13, 17

Icons,
Adobe Illustrator EPSF files 22

MacWrite file 14

MC View Plus EPSF file 33, 52, 80, 107

MC View Plus TIFF file 33, 52, 80, 107

Quark's MacWrite filter 14

ImageWriter 21, 51, 79, 106
Indents 13

Kerning 17

Leading 13, 17

Letterspacing 17

Line art Output see Scan selections

Line length 13-15

Linking text boxes 13-14

MacWrite,

editing

filter 13-14

graphics 13

icon 14

save formats 11

typographic options

Magnetic tapes 117

Margins 13

Memory,
requirements 48, 49-50, 51, 59, 76, 77-78, 79, 105-106, 113, 118

storage limitations 116-117

Missing/modified picture 34-35, 53-54, 81-82, 87, 108-109

Modifications of image,
Computer-generated artwork 25

Contone Output 41, 43, 44, 50, 70, 71, 72, 78

Halftone Output 41, 42, 69, 70

Line art Output 102

Moire patterns 69, 90

Monitor viewing 23, 35, 42, 43, 44, 49, 50, 54, 55, 70, 71, 72, 77, 78,

82, 83, 109

New lines and paragraphs 13-14

Optical disks 117

Page break and style 13

Path 24, 34, 35, 53, 54, 81, 82, 108, 109, 113, 115-116

Pattern menu 101

Photoreceptor 31, 47, 75, 105

Picture box,
activate 19, 21, 29, 32, 46, 51, 74, 79, 103, 106

blank 22, 33, 52, 80, 107
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Pixel,
digital information 31, 47-48, 75-76, 105

editing 28, 102

gray levels 48,76,105

Point size 13,17

PostScript,
as part ofEPSF 21, 24, 32, 35, 51, 54, 79, 82, 106, 109, 115-116

spiling 25

warning box 22, 35, 54, 82, 109

Preview picture 32, 35, 51, 53, 55, 79, 81, 83, 106, 108, 115-116

Resolution,

affecting gray levels 48, 76

high resolution output 27, 41, 43-44, 50, 69, 71-72, 78, 99,

100, 119

low resolution output 24, 27, 35, 41, 42-43, 48, 54, 69, 70-71,

76, 82, 99, 100, 102, 109, 115

output resolution for fine art 28, 101, 118

scanning resolution for Halftone Output 45, 60, 63, 73, 93, 118

scanning resolution for line art 101, 118

Rules 39,66,96,114

Save format selections,

available in MacWrite 11

available in Adobe Illustrator 19

available inMC View Plus for line art 27, 28-29

available inMC View Plus for continuous tones 41-44, 45-46,

48-51

available inMC View Plus for halftones 69-72, 73-74, 76-78

available inMC View Plus for halftone diagrams 100, 102-103,

105-106

EPSF (Encapsulated PostScript),
as Contone Output 44, 46, 50, 59, 72, 73, 78, 87, 111

as Halftone Output 42, 45, 48-49, 70, 73, 76-77, 112

as Line art Output 27, 29, 89, 100, 103

general 19, 32, 51, 50, 79, 90, 106, 115-116

Paint format 32, 36, 55, 83, 106, 110

PICT (Picture) format,
as a save format 32, 106

as part ofEPSF 21, 23, 32, 35, 51, 54, 70, 82, 106, 109, 115

PostScript Only 19

Save 11

Save As 11

Save Text 16

TIFF,

as Contone Output 43, 46, 49-50, 58, 71, 73, 77-78, 86,
111

as Halftone Output 57, 85

as Line art Output 27, 28, 88, 100, 102

CCITT 31

general information 31, 50-51, 78-79, 105

icons 33

PackBits 31

Uncompressed 27, 28, 31, 36
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Scaling,
Adobe Illustrator 25

Contone Output 50, 65, 78, 95

Halftone Output 41, 48, 49, 61, 65, 69, 76, 77, 91, 95

line art 29, 38, 113

Paint format 32

Scan selections,

characteristics of,

Contone Output 41, 43-44, 49-50, 58-59, 70, 71-72,

86-87, 111

Halftone Output 41, 42, 48-49, 57, 61, 69, 70, 85, 91, 112

Line art Output 27, 56, 84, 88-89, 99, 100, 105

factors affecting selection 27, 41, 69, 99

how to select the scan 27-28, 45, 73, 100

Screen preview 21, 23, 32, 34, 51, 53, 79, 81, 106, 108

Show invisibles 14

Step and Repeat function see Duplicating
Style menu options,

EPSF file 27, 29, 67, 97. 100

Halftone screening 6264

Paint file 32,106

PICT file 32,106

TIFF file 27, 28, 67, 97, 100, 102

Style sheets 15

Tabs 13,14

Template 21

Text,
alignment 13

editing 16

formats 12-13

MC View tool 39,66,96,114

overflow 13

style 13

Text box,

activating 11

linked 13

Threshold option 31, 101, 105

TIFF formats see Save formats

Tone compensation see Contrast controls

Tool palette 11,17

Tracking 17

Typography,

style 13

comparison of functions in Quark andMacWrite 16, 17

Unlinking text boxes 14

View menu 14

Word spacing 13, 17

Index 137
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